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Accountant’s Review Copy

About an Accountant’s Review Copy

An Accountant’s Review is made when your accountant needs the file to review and to make some adjustments to your books, but you cannot afford to lose access to your books yourself.  By giving an accountant’s review copy of your data to your accountant, you can continue your day-to- day operations with QuickBooks while your accountant enters the adjustments. 

When your accountant finishes, you merge the accountant’s changes along with your own.  

♣Note: You will lose the ability to perform some functions within QuickBooks while your accountant has the review copy.  These functions include deleting a list entry, renaming existing accounts or items, and reorganizing your lists.  However, you will not lose the ability to perform daily activities like time tracking, recording deposits, invoicing, Creating new list entries, customer entries, vendor entries, etc.

♣You should make a backup copy of your QuickBooks file before merging an Accountant’s Review Copy.  Backing up is a safeguard in case anything goes wrong when you try to merge the changes.  For instructions on how to create a backup copy, please refer to the section in this book, “Backing Up Company Data”.

Making an Accountant’s Review Copy

1. From the “File” menu within QuickBooks, choose “Accountant’s Review “and then choose “Create Accountant’s Copy”.

2. The Save Accountant’s Copy to box will appear. You can either change the filename or keep the file name that QuickBooks suggests for the accountant’s copy (usually the company name and the .QBX extension.)  You do not have to change the name, but if you do, the file name you assign must have a .QBX extension.

3. Change the suggested location for the file, if necessary.  Most people will be sending the Accountant’s Review to their accountant, so the review must be saved to a 3.5-inch disk, so make sure that you are at the a: drive.  If you are putting the file on a 3.5-inch disk, insert the disk and choose your disk drive as the “Save In” location.

4. Click “Save”.

♣The phrase “Accountant’s copy exists” appears in the title bar of the QuickBooks program window, and will remain there until you have received your disk back from your accountant and merged the accountant’s changes into your QuickBooks file.

5. If you are emailing the file, save to your hard drive.  Then go into your e-mail and attach the file on your hard drive.  The file is going to have .QBX extension.

Accountant’s Review Copy
Merging your Accountant’s Changes

When you receive the Accountant’s Review file back from your accountant you need to merge the file with your current QuickBooks file.  The file will normally be on a 3.5” disk or e-mail attachment with the extension of “.AIF”.

You should make a backup of your company data before attempting to merge the accountant’s changes.  See the instructions for “Backing Up Company Data” to learn how to do this.

1. If the accountant’s changes are on a floppy disk, insert the disk into your floppy drive.

2. Open the master company file.  Then from the “File” menu, choose “Accountant’s Review”, and then choose “Import Accountant’s Changes”.

3. When the message about backing up your data appears, click “OK”.

♣Backing up is a safeguard in case anything goes wrong when you try to merge the changes.

4. Enter the filename and location for the backup file and click “Back up”.  When the “Import Changes from Accountant’s Copy” window appears, select the drive that contains the file (usually your a: drive) and click “Open”.

KEEPING AN AUDIT TRAIL
The Audit Trail Feature is designed to maintain a record of all changes made to transactions.  Each time a transaction is created, modified, or deleted, QuickBooks keeps a record of the change within the data file.  A record of the user who made a particular change is also maintained. All of this information is accessible by running the Audit Trail Report.

To activate the audit trail feature, the administrator must take the following steps:

1. From the EDIT menu, choose Preferences.
2. In the Preferences window, select “Accounting” in the scroll box.

3. Select the “Company Preferences” tab and click the “Use Audit Trail” checkbox

4. Click OK

♣ Note:  Having the Audit trail on can slow down the performance of the software.  If you are having trouble with the performance, turn the Audit trail off.

CLOSING YOUR BOOKS
These steps will prevent you from changing any information from previous years. You need to be logged in as an Administrator to do this.  The Administrator will still have access and the ability to change any information at all times.  The only way to make this useful to your company is to make sure each user has their own login name – This will enable you to limit that particular person from changing any information. The administrator login should not be used for entering data.

1. You must be in Single User Mode.

2. From the Company Menu, choose setup users.

3. Click on the closing date.

4. Enter the closing date and click OK.

5. To limit another user from having access to transactions entered before the closing date, do the following:

a) From the User List, Select the name of the User.

b) Click Edit User.

c) Click Next until the changing or deleting transactions window appears.

d) Select NO in response to the question:  Should this user also have the ability to change or delete transactions that were recorded before the closing date?  This will not allow the user to edit, delete, or void transactions before the closing date.

         BACKING UP YOUR QUICKBOOKS FILE

About Backups

The QuickBooks Backup command does not simply copy the data for your QuickBooks Company. Instead, it compresses the data into a compact file that is smaller than your company file. To protect your information from a hard drive failure it is recommended that you back up your data at the end of each session. If your computer has more than one drive, back up onto a different drive from the one where you keep your working data. You should backup onto either a zip drive or 3.5 inch disk, CD or some other media source.

Backup copies are important insurance because if you should lose data for any reason you can restore that data from your backup copy.  You should make a backup copy of your QuickBooks Company on a daily basis. 

Before you perform several functions within QuickBooks, the program will ask you to make a backup copy first.  For example, before you create an Accountant’s Review Copy, QuickBooks requests that you make a backup of your file before it will perform the function, to protect your information if something were to be lost while creating the Accountant’s Review Copy.

How to backup company data – YOU MUST BE IN SINGLE USER MODE

1. If you are backing up to a disk, put the disk in the disk drive (A: drive) of your computer. QuickBooks will display a message if the disk needs to be formatted prior to backup.  Do not choose “Quick Format”; instead, choose “Full Format” option.

♣Caution: Even if it’s labeled as preformatted, it’s a good idea to fully format a new disk before using it. Sometimes new disks can be stripped of their formatting during shipping.  If you are backing up to another source go to the drive which you are backing up to.

2. From the “File” menu, choose “Back Up”.

3. In the “Back up Company File” window, choose a drive where the file will be saved in by clicking on “Browse.”   If you are using a disk, choose “3.5 inch disk (A: Drive)”, from the drop down list, in which to save the file.  If you are using another source, choose the drive letter which you are backing up to.

4. Give the backup a name.  QuickBooks puts the company name in the “File Name” field by default.  You can change the name if you feel it is more appropriately called something else, but you do not have to.  You can use the company name plus the date, for example.

5. The “Save as Type” should already read “QBW Backup (*.QBB)”.  Do not change this.

6. Click Save.

♣For large files you will need more than one disk.  QuickBooks asks you to insert an additional disk as each disk fills up. Be sure to label the disks so that you will know which one was first, which was second, and so on. This will help you if you ever need to restore the data from the disks.  If you are using a lot of disks, I would suggest you use another source.

7.  When the filename and location have been selected, click on “Back Up”

BACKING UP YOUR QUICKBOOKS FILE

Tips:

1.
Each day, back up your file and keep in the office. 

2.
At least once a week, make a backup copy to keep off premises.

♣For your monthly backups, you may want to alternate between two     sets of disks. If disaster strikes your office, you’ll want to have a reliable record of your data to fall back on.

3. At the end of your fiscal year, make an archive copy of your data to keep off the premises.

BACKING UP YOUR QUICKBOOKS FILE

Restoring Data from a Backup Copy

If you have created a backup copy of your company data, you can bring the backup copy back into QuickBooks by using the Restore command.  Restore creates a new QuickBooks company using the data from the backup copy. You may need to do this if one of the following has occurred:

Your working data has been damaged.

Your hard drive has malfunctioned.

You need to put the data on another computer.

You want your data to revert to the state it was in at an earlier date.

Restoring a local Backup

1. If the backup copy is on a removable disk, put the disk in your disk drive.  If the backup is on several disks, insert the first disk in the disk drive.

2. From the File menu, choose Restore.

3. In the upper section of the window, click Disk; then click Browse to select the location and filename of the backup file.

4. In the lower section, click Browse to select or change the location and filename to which you want to restore your back file.

5. Click Restore.

6. Respond to any messages QuickBooks may display.  

♣If QuickBooks finds a company file with the same name in the folder you specified, QuickBooks asks you if you want to replace the existing file. If you click “Replace”, QuickBooks erases the existing file from your hard disk and replaces it with the file you are restoring. To be absolutely safe, click “Cancel” and give the file you are restoring a different name.

♣If your backup file spreads over more than one disk, QuickBooks will ask you to  

  insert the next disk when it is finished with the first one.

Restoring a remote online backup – not available in the Healthcare editions

If you backed up your company file using the online backup service, you must restore it through that same service.

1. From the File menu, choose Restore.

2. Select Online to restore a company file that you backed up using the Online Backup service (for more information, click “Tell Me More” in the QuickBooks Backup window).

3. Click Restore and then follow the onscreen directions until you have retrieved the file.

4. From the File menu, select Open Company.

5. Select the file you have retrieved and click Open.

BILLS

Entering a bill for expenses

You can enter a bill for any kind of expense you track through expense accounts.

1.   From the “Vendors” file choose “Enter Bills”

2.   In the “Vendor” field, choose or enter a new vendor.

(If an open purchase order exists for this vendor, you are prompted to receive against it.

1.   Click Yes to receive against one or more purchase orders.

2. In the “Open Purchase Orders” window, click each purchase 

Order that contains items you've received and are being billed for.

3.   Click OK. 

( All item information (quantity received, etc.) can be edited.

3.   (Optional) Change the date of the bill.

4.   In the” Amount Due” field, enter the amount of the bill.

5.   Complete the “Ref. No”, “Terms”, and ”Memo” fields as needed.

6.   In the detail area, assign the bill to one or more expense accounts.

7. (Optional) To correct mistakes in the detail area, click “Clear Splits” or “Recalculate”.

8. Click “Save & Close” to save the transaction and close the window. Click “Save & New” to save the transaction and enter a new one.

Entering a bill for items

You can enter bills for the following types of items: inventory part, non-inventory part, service, other charge and fixed asset (available only in QuickBooks Pro and higher editions). 

1.   From the “Vendors” file choose “Enter Bills”

2.   In the “Vendor” field, choose or enter a new vendor.

( If an open purchase order exists for this vendor, you are prompted to receive against it.

1.   Click Yes to receive against one or more purchase orders.

2.   In the Open Purchase Orders window, click each purchase order that contains items you've received and are being billed for.

3.   Click OK. 

(All item information (quantity received, etc.) can be edited.

3.   (Optional) Change the date of the bill.

4.   In the “Amount Due” field, enter the amount of the bill.

5.   Complete the “Ref. No”, “Terms”, and “Memo” fields as needed.

6. Click the “Items” tab. You can edit items that were entered from your purchase order and/or enter new items.

( If the item you’re purchasing is a fixed asset.

1. In the Items column, choose <Add New> and fill out the information.  Important:  Do not select a similar item and edit it.  Each fixed asset must be unique so you can track it for tax purposes.  If you are using the Premier version, it will allow you to use it as a fixed asset program.

2. Repeat these steps to enter more fixed asset items.

( What if there is no Items tab?

1. It means that the inventory preference is off.  When the inventory preference is turned on, QuickBooks adds an Expense tab and an Items tab to the detailed area of the Write Checks, Enter Credit Card Charges, and Enter Bills windows.

7.   To enter shipping charges or taxes not associated with any one item, click the Expenses tab. In the detail area, enter each charge and associate it with its correct expense account.

8. (Optional) Click Recalculate.

9. Click “Save & Close” to save the transaction and close the window. Click “Save & New” to save the transaction and enter a new one.

Overview of Paying Bills

In the Pay Bills window, QuickBooks lists all unpaid bills or all bills due as of a date you enter. You mark the bills you want to pay, and QuickBooks then writes and saves the checks or credit card charges. 

You don't have to use the Pay Bills window. You can enter checks, credit card payments, and cash expenditures in the appropriate account register. However, if you've entered bills into QuickBooks using the Enter Bills window or the Accounts Payable register, you must use the Pay Bills window for your bill payment.

Paying a bill with a check

1.  From the “Vendors” menu choose “Pay Bills”

( What if I don’t see all my bills?

1. If you have more than one accounts payable account, choose the one you want to use to pay these bills.  If you want, you can change the order in which the bills appear in the list or click show all bills.


2.  In the left had column, select the bills to be paid

3.  Set any discount or credits that you want to apply to the bill.

4.  From the Payment Method drop-down list, choose Check.

1. If you plan to print this check from the QuickBooks, select the “To be printed” check box.

2. If you plan to hand write the check, if you’re using a debit card, or wire, select the “Assign check no.” checkbox.  When you record your bill payment after completing this form, you’ll be prompted to enter check numbers and dates.  If you are wiring the amount, enter wire in the check number column.

5. From the Payment Account drop-down list, choose the account from which you want to pay the bills.

6. QuickBooks automatically enters today’s date in the Payment Date field.  This is the date that will appear on your printed checks.  You can change this date, if needed.

7. Record the bill payment.

( What happens when you record a bill payment?

1. QuickBooks prepares one check for each vendor and records the checks in the check register with BILLPMT in the Type field.

2. If you need separate checks printed for a vendor.  Make sure that you setup separate vendors.

Paying a bill with a credit card

1.   From the “Vendors” menu choose “Pay Bills”

( What if I don’t see all my bills?

1. If you have more than one accounts payable account, choose the one you want to use to pay these bills.  If you want, you can change the order in which the bills appear in the list.

2.  In the left hand column, select the bills to be paid.

3.  Set any discount or credits that you want to apply to the bill.

4.  From the Payment Method drop-down list, choose Credit Card.

5. From the Payment Method drop-down list, choose the account from which you want to pay the bills.

6. Check the date.  This is the date that will print on the check.

7. Record the bill payment.

( What happens when you record a bill payment?

1. QuickBooks records a charge for each vendor in your credit card register.

Paying a bill with cash

1.   From Vendors menu, choose Pay Bills.

( What if I don’t see all my bills?

1. If you have more than one accounts payable account, choose the one you want to use to pay these bills.  If you want, you can change the order in which the bills appear in the list.

2. In the left hand column, select the bills to be paid.

3. Set any discount or credits that you want to apply to the bill.

4. From the Payment Method drop-down list, choose Check.

5. From the Payment Account drop-down list, choose the account from which you want to pay the bills, such as Petty Cash.

6. Select the “Assign check no.” checkbox.  When you record your bill payment after completing this form, you’ll be prompted to enter check numbers and dates.  You can leave the check number blank or you can enter something else, such as “Petty Cash”.  For a debit card payment or an electronic funds transfer, you might enter “EFT”.

7. QuickBooks automatically enters today’s date in the Payment Date field.  You can change this date, if needed.

8. Record the bill payment.

( What happens when you record a bill payment?

1. QuickBooks records a payment for each vendor in your cash account register.

Applying Credits to a Bill Payment

1. Complete the bill payment information for payment by Check, Cash, Credit Card, or On Line Banking Payment, but do not record the payment.

2. Select and highlight the bill to which you want to apply one or more credits.

3. Click Set Credits.

4. In the Discount and Credits window, select each credit that you want to use for this bill.  As you select each credit, the change is reflected in the Amount Due, Credits Used and Amount to Pay values in the Bill information section at the top of the window.

5. (Optional) If you only want to use part of a particular credit, change its amount in the Amount to use column.

6. Click Done.

( What happens when you apply a credit?

1.
Credits are applied against the selected bills (for the same vendor) in the order that the bills are selected.  The oldest credit is applied first.  Discounts are applied prior to applying any credits.  The change the way in which a credit is applied, highlight the bill, then click Set Credits.

BUDGETING

About Budgeting

QuickBooks provides the ability for creating budgets so you can see how well your company is meeting your budget goals.  For each account, customer or job, and class combination, you can create one budget per fiscal year.  For example, if you create a 1999 budget for lumber (an expense account) for the Harahan remodel (a job for your customer Harahan), you cannot create a second 1999 budget for lumber on the Harahan remodel.

However, you can create as many separate budgets as you want within the same fiscal year as long as each budget applies to something different.  For example, it’s OK to have a 1999 budget for lumber for the Harahan remodel and a 1999 budget for lumber on the O’Conner remodel (the Harahan and O’Conner remodels are different Customer:Job combinations).

Creating a budget for income and expense accounts 

To see variances between budgeted and actual amounts by time period, set up budgets for accounts without a customer, job or class.

1. Display the Set Up Budgets window.  From the Company menu, choose Planning & Budgeting, then Set Up Budgets.

2. Click Create New Budget.

3. Select the year and type of budget you want to create.

4. Select “No additional criteria”.

5. Then choose whether you want to create the new budget from scratch or from previous year’s actual data.

( What’s the difference?

1. Create the budget from scratch.  You manually enter amounts for each account you want to track.

2. Create the budget from previous year’s actual data.  QuickBooks automatically enters the monthly totals from last year for each account in the budget.

6. Click Finish.

7. Enter or modify budget amounts, then click Save.

Creating a budget for a customer or job

1. Display the Set Up Budgets window.  From the Company menu, choose Planning & Budgeting, then Set Up Budgets.

2. Click Create New Budget.

3. Select the year and type of budget you want to create.

4. Select Customer:Job.

5. Then choose whether you want to create the new budget from scratch or from previous year’s actual data.

( What’s the difference?

1. Create the budget from scratch.  You manually enter amounts for each account you want to track.

2. Create the budget from previous year’s actual data.  QuickBooks automatically enters the monthly totals from last year for each account in the budget.

6. Click Finish.

7. In the Set Up Budgets window, choose the Customer:Job from the drop-down list.

8. Enter or modify budget amounts, then click Save.

Copying a budget to a new year

1. From the File menu, choose Export, then choose Lists to IIF Files.

2. In the Export window, choose Budgets.

3. Click OK.

4. In the next Export window, enter a filename (like budget.IIF).  It must have an .IIF extension.

5. Open the budget.IIF file with a spreadsheet editor, such as Microsoft Excel.

6. Change the year in the column called STARTDATE.

7. Save the changes.

8. In QuickBooks, from the File menu, choose Import then choose IFF Files.

9. Select the budget.IIF file in which you changed the date.

BUDGETING

Editing a budget

It is helpful to have a paper copy of your budget at your side while you make changes.  You can print a report that lets you see budget amounts (Instructions below).

1. Display the “Set Up Budgets” window.  From the Company menu, choose Planning & Budgeting, then Set Up Budgets.

2. Choose the budget, and if necessary, Customer:Job and Class that describe your budget.

3. When QuickBooks displays the monthly budget amounts, change the amounts as desired.

4. Click “Save”.

5. (Optional) Choose another budget (and if necessary, Customer: Job and Class), and repeat Step 3 and Step 4.

6. When you are finished entering all the changes, click “OK”.

Printing Budget Amounts

To see budget amounts, use a “Budget Overview” report.

1. From the “Reports” menu, choose “Budget “.

2. Choose the appropriate overview report, depending on how your budget is set up:

♣Choose “Profit and Loss Budget Overview” if you would like to see a print out of the Income and Expense accounts budget you have set up.

♣Choose the “Profit and Loss Budget By Job Overview” report if you would like to see the budget for a particular Customer or Job.  Click “Customize” and in the “Columns” field, choose either a date value (like month) or “Total Only,” and in the “Rows Axis” field, choose “Customer:Job”.

♣To see a budget by class, choose the “By Job Overview” report and click Customize”.  In the “columns field, choose either a date value or “Total Only'con to make the note active again. imply click on the  Format window you can edit the dexcription when you are filling out a sa, and in the “Rows Axis” field, choose “Class”.

♣To see a budget by Customer:Job and Accounts, choose the “By Job Overview”.  Click “Filter”, and choose “Name” in the “Filter” field, then click “OK”. 

♣For Balance Sheet accounts choose “Balance Sheet Overview”.  This report shows monthly budget amounts for each balance sheet account for which you have entered a budget amount.

♣For Balance Sheet comparison, choose “Balance Sheet Budget vs. Actual”.  This report shows monthly budget amounts for each balance sheet account for which you have entered a budget amount.  It also shows the actual account balances as of the last day of the month, the difference between your budgeted and actual account balances, and the difference between your budgeted and actual account balances, shown as a percentage of the budgeted amount.

3. Once you have the report that shows the parts of the budget you want to print, click

the “Print”.

WRITING A CHECK

Manual Check

Follow these instructions if you intend to enter a manual check that was written.

1. Click on the “Check” icon on your toolbar, or select the “Banking” menu and choose “Write Checks”.

2. In the “Bank Account” field at the top left corner of the “Write Checks” window, choose the checking account out of which the check was written.

3. Enter the check number of the check you are entering in the “No.” field.

4. In the “Date” field, enter the date that you wrote the check.

5. On the “Pay To The Order Of” line, write the name of the person/company to whom you are writing the check.  

A. If this vendor has already been set up within QuickBooks, QuickBooks will automatically enter the name of the closest match to the name as you start to type.  (You can also use the drop-down list to enter the name.)  When the name appears as you would like it, hit the tab key on your keyboard or use the mouse to click on the next field you would like to enter.  (This will typically be the “$” field immediately to the right of the “Pay to the order of” line.)

1. If your preferences are set to recall the last transaction, when you enter the name, the last transaction for this vendor is going to show on your screen.  Usually all you need to do is change the amount you enter, if the account is correct.  If you need to change anything, you can use your mouse to click on any field and enter the correct information.

B. If this vendor has not been previously used (or set up) QuickBooks will prompt you with a “Name Not Found” window which provides you with these three choices: “Quick Add”, “Set-up”, and “Cancel”.  (QuickAdd allows you to enter just the name of the vendor whereas Setup allows you to enter all the vendor information including address, phone number, account number, etc.)  Use your mouse to click “Set-up” and QuickBooks will prompt you with the “Select Name Type” window.  Click the button next to “vendor” then click “Save and Close”.

C. You will now see the “New Vendor” window where you will fill in the fields for “Vendor; Company Name; Address; Print on Check as”.  The other fields you should fill in if you have the proper information to enter.  These will not affect your ability to write a check.  Click on the “Additional Information” tab, and enter the account number for the vendor if applicable.  If you enter the account number here, it will print in the memo section of the check.  When you have entered all the appropriate information, click “Ok”.  (For more detailed instructions about how to set up a vendor see the section on “Setting up a Vendor” in this book.) 

6. Hit your tab key to move to the next field when you have finished filling out the “Pay To The Order Of” field.  QuickBooks moves you to the “$” (Amount) field (you can also use your mouse to click on this field to move your cursor to it.)  In this field you will enter the amount you are writing the check for.  You must remember to enter the decimal unless the number you are entering is an even dollar amount.  In this case QuickBooks automatically fills in zeros as ‘cents’. 

7. When you hit your tab key to move to the next field, QuickBooks writes the amount of the check out in words for you and moves you to the “Address” field.  The address should already be entered because you have previously entered this information when you set up the vendor.  (You can alter the address if you need to.   However, when you save at the end of the transaction QuickBooks will notify you that you have changed address information for this transaction and ask you if you want this new information to show up the next time you write a check to this vendor.  Typically the information is a permanent change, click “Yes”, to have the information registered as a permanent change.)

8. “Memo” - any information you enter in this field will be printed on the memo section of the check.  This space is often used to write your account number for the vendor associated with the invoice you are paying or any other detail you want to give the vendor, like the invoice number you are paying.  Anything you enter here will not be seen on the General Ledger or anywhere else in QuickBooks, except in this check template.  If you entered the account number in the “Additional Information” tab when this vendor was set up, it will automatically print on your check every time, but not anywhere else in QuickBooks (except of course in the Vendor Setup window).   This is a time-saver feature QuickBooks has created to save you the time entering your account number each time you create a check.

9. In the “To Be Printed” box in the middle of the “Write Checks” window: Unclick the “To Be Printed” box so that the check mark does NOT appear within the box.

10. In the “Online Payment” box in the middle of the check template in the “Write Checks” window: Unclick the “Online Payment” box so a checkmark does NOT appear within the box.

11. When you hit tab, you will move to the “Account” column on the “Expenses” tab.  You will see the amount you have written the check for in the column immediately to the right of the “Account” column.  You use these columns to enter the information regarding what expense accounts are going to be assigned to the purpose of the check.  You begin to enter the name of the account, or you can choose the drop down arrow in the right side of the column to pick the account you are assigning an amount of the check to.  When you have entered the account, hit the tab key.

12. You will now be moved to the “Amount” column.  QuickBooks has already entered the amount you have written the check for.  

A. If the entire amount is being assigned to the same expense account you can hit tab.

B. If only part of the amount is being assigned to this account, enter that amount now and hit tab. (QuickBooks will automatically enter the balance of the check into the amount column directly underneath this entry when you have tabbed through the other columns.)

C. Type a memo of what the expense is in the “Memo” column.  Whatever you type in this column will be able to be seen in the General Ledger (as opposed to the memo field on the check template).  Hit the tab key.

D. If applicable, enter a Customer:Job name in the “Customer:Job” column (again, you can use the drop down list, if you are more comfortable doing so).  If you assign the expenses or items to a customer, you will be able to import the information to an invoice for that customer, and you will be able to print a Profit & Loss report, to assess your gross profit for that Customer or Job.

E. When you enter a Customer:Job, you will see a picture of an invoice appear in the next column.  If you are billing this cost back to a client leave the invoice as is.  If you are not billing this cost back to the client, (i.e.- entering the Customer:Job as a means of tracking business costs back to specific jobs.), you should use your mouse to click on the picture of the invoice in order to make an “X” appear on top of the invoice icon.   

F. If you are splitting the total amount into separate expense accounts, continue following steps B-E until the entire amount of the check has been placed in the appropriate expense accounts.

13. You can also split the amount of the check into items on the “Item” tab.  The “Item” tab should be used for reimbursable items.  If you have items set up that you use to invoice your clients, and you have received these items (either purchases or services) from an outside vendor that you are now paying, this is the space that you use to split the amount of the check you are creating.  Like above you will see several columns in which you are required to make entries before the check is created.

A. Fill in the “Item” column with the specific item (or service) you are splitting out, by either typing in the item or using the drop down list to choose an item.

· If the item is not already set up QuickBooks will prompt you to set it up.  You will then see the “New Item” window.  

· Choose the type of item it is from the drop down list in the “Type” field.

· Give the item a name (or number) in the “Item Name” field.

· Fill in the “Purchase Information” field, making sure to assign a Cost of Goods Sold/Expense account to the item.  

· Fill in the “Sales Information” field, making sure to assign an Income account to the item.

· If this is an item you typically keep in stock, be sure to fill in the “Inventory Information field.”

· Click “Ok” when all the applicable information has been entered.

· (For more information on how to set up items, see the instructions in this book for “Creating Items”.)

B. Fill in the “Description” and “Quantity” columns.  The “Cost” and “Amount” columns QuickBooks should already have calculated for you because that information was set up when you set up the item.

C. Assign a Customer:Job if applicable, and as on the Expense tab, click on the picture of the invoice to put an “X” on it if you do not want to charge the expense back to the customer.  

14. When you are finished entering all the information, the amount shown on the Expense tab, and the amount shown on the Items tab should equal the original amount that you entered in the “$” field in the check template.  

15. If these amounts do not total to the amount for which you are writing the check you have not assigned all the costs to the various expense/item accounts and you will need to go back and check that everything is entered correctly.  QuickBooks will not accept the transaction until everything is in balance.

16. When everything is entered click “Next” or “Save & New” to write another check, or click “Save & Close” if you are done writing checks.

WRITING A CHECK

Online Payment

Follow these instructions if you intend to enter a check to make a payment online.

1. Click on the “Write Check” icon on your toolbar, or select the “Banking” menu and choose “Write Checks”.

2. In the “Bank Account” field at the top left corner of the “Write Checks” window, choose the checking account from which you would like to write this check.

3. On the “Pay To The Order Of” line, write the name of the person/company to whom you are writing the check.  

A. If this vendor has already been set up within QuickBooks, QuickBooks will automatically enter the name of the closest match to the name as you start to type.  When the name appears, as you would like it, hit the tab key on your keyboard or use the mouse to click on the next field you would like to enter. (This will typically be the “$” field immediately to the right of the “Pay to the order of” line.)

1. If your preferences are set to recall the last transaction, when you enter the name, the last transaction for this vendor is going to show on your screen.  Usually all you need to do is change the amount you enter, if the account is correct.  If you need to change anything, you can use your mouse to click on any field and enter the correct information.

B. If this vendor has not been previously used (or set up) QuickBooks will prompt you with a “Name Not Found” window which provides you with these three choices: “Quick Add”, “Set-up”, and “Cancel”.  (QuickAdd allows you to enter just the name of the vendor whereas Setup allows you to enter all the vendor information including address, phone number, account number, etc.)  Use your mouse to click “Set-up” and QuickBooks will prompt you with the “Select Name Type” window.  Click the button next to “vendor” then click “Save & Close”

C. You will now see the “New Vendor” window where you will fill in the fields for “Vendor; Company Name; Address; Print on Check as”.  The other fields you should fill in if you have the proper information to enter.  These will not affect your ability to write a check.  Click on the “Additional Information” tab, and enter the account number for the vendor.  You must enter the account number here in order to make an online payment.  When you have entered all the appropriate information, click “Ok”.  (For more detailed instructions about how to set up a vendor see the section on “Setting up a Vendor” in this book.) 

4. Hit your tab key to move to the next field when you have finished filling out the “Pay To The Order Of” field.  QuickBooks moves you to the “$” (Amount) field (you can also use your mouse to click on this field to move your cursor to it.)  In this field you will enter the amount you are writing the check for.  You must remember to enter the decimal unless the number you are entering is an even dollar amount.  In this case QuickBooks automatically fills in zeros as ‘cents’. 

5. When you hit your tab key to move to the next field, QuickBooks writes the amount of the check out in words for you and moves you to the “Address” field.  The address should already be entered because you have previously entered this information when you set up the vendor.  (You can alter the address if you need to.   However, when save at the end of the transaction QuickBooks will notify you that you have changed address information for this transaction and ask you if you want this new information to show up the next time you write a check to this vendor.  Typically the information is a permanent change. Click “Yes”, to have the information registered as a permanent change.)

6. “Memo” - any information you enter in this field will be printed on the memo section of the check.  This space is often used to write your account number for the vendor associated with the invoice you are paying or any other detail you want to give the vendor, like the invoice number you are paying.  Anything you enter here will not be seen on the General Ledger or anywhere else in QuickBooks, except in this check template.  If you entered the account number in the “Additional Information” tab when this vendor was set up, it will automatically print on your check every time, but not anywhere else in QuickBooks (except of course in the Vendor Setup window).   This is a time-saver feature QuickBooks has created to save you the time entering your account number each time you create a check.

7. When you hit tab, you will move to the “Account” column on the “Expenses” tab.  You will see the amount you have written the check for in the column immediately to the right of the “Account” column.  You use these columns to enter the information regarding what expense accounts are going to be assigned to the purpose of the check.  You begin to enter the name of the account, or you can choose the drop down arrow in the right side of the column to pick the account you are assigning an amount of the check to.  When you have entered the account, hit the tab key.

8. In the “To Be Printed” box in the middle of the “Write Checks” window: Unclick the “To Be Printed” box so that the check mark does NOT appear within the box.

9. In the “Online Payment” box in the middle of the check template in the “Write Checks” window: Click the “Online Payment” box so a checkmark does appear within the box.  If you have not setup the vendor with an account number QuickBooks will prompt you to enter the account number now.  QuickBooks will NOT allow you to enter any more information for an online payment until you have entered an account number. (See section 5B & 5C for instructions to do this.)

10. You will now be moved to the “Amount” column.  QuickBooks has already entered the amount you have written the check for.  

A. If the entire amount is being assigned to the same expense account you can hit tab.

B. If only part of the amount is being assigned to this account, enter that amount now and hit tab. (QuickBooks will automatically enter the balance of the check into the amount column directly underneath this entry when you have tabbed through the other columns.)

C. (Type a memo of what the expense is in the “Memo” column.  Whatever you type in this column will be able to be seen in the General Ledger (as opposed to the memo field on the check template).  Hit the tab key.

D. If applicable, enter a Customer:Job name in the “Customer:Job” column (again, you can use the drop down list, if you are more comfortable doing so).  If you assign the expenses or items to a customer you will be able to import the information to an invoice for that customer.  You will also be able to print a Profit & Loss report to assess your gross profit from that customer.

E. When you enter a Customer:Job, you will see a picture of an invoice appear in the next column.  If you are billing this cost back to a client leave the invoice as is.  If you are not billing this cost back to the client, (i.e.- entering the Customer:Job as a means of tracking business costs back to specific jobs.), you should use your mouse to click on the picture of the invoice in order to make an “X” appear on top of the invoice icon.   

F. If you are splitting the total amount into separate expense accounts, continue following steps B-E until the entire amount of the check has been placed in the appropriate expense accounts.

11.  You can also split the amount of the check into items on the “Item” tab.  Items should be used for reimbursable expenses.  If you have items set up that you use to invoice your clients, and you have received these items (either purchases or services) from an outside vendor that you are now paying, this is the space that you use to split the amount of the check you are creating.  Like above you will see several columns in which you are required to make entries before the check is created.

A.  Fill in the “Item” column with the specific item (or service) you are splitting out, by either typing in the item or using the drop down list to choose an item.

· If the item is not already set up QuickBooks will prompt you to set it up.  You will then see the “New Item” window.  

· Choose the type of item it is from the drop down list in the “Type” field.

· Give the item a name (or number) in the “Item Name” field.

· Fill in the “Purchase Information” field, making sure to assign a Cost of Goods Sold/Expense account to the item.  

· Fill in the “Sales Information” field, making sure to assign an Income account to the item.

· If this is an item you typically keep in stock, be sure to fill in the “Inventory Information field.”

· Click “Ok” when all the applicable information has been entered.

· (For more information on how to set up items, see the instructions in this book for “Creating Items”.)

B. Fill in the “Description” and “Quantity” columns.  The “Cost” and “Amount” columns QuickBooks should already have calculated for you because that information was set up when you set up the Item.

C. Assign a Customer:Job if applicable, and as on the Expense tab, click on the picture of the invoice to put an “X” on it if you do not want to charge the expense back to the customer.  

12. When you are finished entering all the information, the amount shown on the Expense tab, and the amount shown on the Items tab should equal the original amount that you entered in the “$” field in the check template.  

13. If these amounts do not total to the amount for which you are writing the check you have not assigned all the costs to the various expense/item accounts and you will need to go back and check that everything is entered correctly.  QuickBooks will not let you enter the transaction until everything is in balance.

14. When everything is entered click “Next” or “Save & New” to write another check, or click “Save & Close” if you are done writing checks.

CREDIT MEMOS

About Credit Memos

Use credit memos to record a return when a customer returns items for which you have already recorded an invoice or cash sale.   

When writing a refund check to a customer, always complete a credit memo first in order to track the sale, return, and refund correctly in QuickBooks.

Entering a Credit Memo 

Use the Create Credit Memos/Refunds window to record a return when a customer returns items for which you have already recorded an invoice, customer payment, or sales receipt.

1. From the Customer menu choose Create Credit Memos/Refunds.

2. In the Customer:Job field, choose the customer or job the return is for by either typing in the name, or using the drop-down list to click on the name you choose. 

3. Select a template.

4. From the Account drop-down list, choose which Accounts Receivable account to use.  This field appears only when you have more than one accounts receivable account (most companies have only one).

5. Enter the items being returned in the line item area.  Use the same information that was on the original invoice or billing statement.  QuickBooks decreases the income accounts of the invoice items by the amount of the return.

6. (Optional) Assign a class to this credit memo.

7. (Optional) In the Customer Message field, choose a message from the drop-down list or enter a new message to your customer.

8. (Optional)  Enter a memo for this transaction.  The memo does not print on the credit memo, but it does appear in the Accounts Receivable register and the customer register.

9. (Optional) Print the credit memo.

10. Save the credit memo.  QuickBooks enters a negative amount in your A/R register for the credit memo.

11. If you now owe the customer money, click Check Refund to create a refund check.  Refer to instructions. 

CREDIT MEMOS

Applying a Credit Memo

1. Choose “Receive Payments” icon if setup or from the “Customer” menu.

2. Choose the customer’s name that you just wrote the credit memo for.  Leave the check amount field blank.  The amount of the credit memo will appear in the “Existing Credits” field.

3. Highlight the invoice you are applying the credit to.  Then click on the “Set Credits” button.  A window will appear, click on the credit and then click on the done button.  The amount will show in the credit column if the display credit is checked.

♣QuickBooks will enter the credit amount in the payment field of the oldest outstanding invoice if you have set QuickBooks to automatically apply payments. If you did not set QuickBooks to automatically apply payments, click in the checkmark column next to the invoice being credited.

♣If you would like to credit a different invoice, you can unclick the checkmark in the left column of the “Receive Payments” window, next to the invoice that QuickBooks has just applied the credit to.  When the checkmark is not next to the invoice, QuickBooks unapplies the amount.  You then click next to the invoice you wish to apply the amount to, and a checkmark appears like the one you just deleted, and QuickBooks applies the credit to the invoice you have just selected.

4. Click “Save & Close”.

CREDIT MEMOS

Writing a Refund Check

1. Display the credit memo you created for the amount and customer you are writing the refund check for.  You do this by clicking “Customers” then “Create Credit Memos/Refunds”.  You can click the “Previous” button until you memo you created and want to write the refund check for, is displayed on your screen.  

2. Click the “Refund” to create the refund check.  QuickBooks will display the “Write Checks” window with a refund check with all the relevant information from this credit memo, already entered.

3. Make sure all the information on the check is correct.

♣Caution: Leave “Accounts Receivable” as the account in the detail area of the refund check. This ensures that QuickBooks will account for the credit and refund correctly.

4. (Optional) Select the “To be printed” checkbox to print this check later, or click “Print” to print the check now.

5. Click “OK” to record the check.

6. Select Receive payments from the icon bar or from the “Company” menu, choose “Receive Payments”.

♣Important: Although you have recorded both the credit memo and the check, you still need to connect the check to the credit memo so that QuickBooks can track the transaction correctly.

7. In the “Customer:Job” field, use the drop-down list to choose the customer to whom you just wrote the refund check.

8. You will see under “Outstanding Invoices/Statement Charges” at the bottom of the screen, a listing under “Type” that says “Refund Chk” for the amount that you just entered in the credit memo.  Enter that amount in “Amount” field at the top right of your screen.  

9. Then click “Save & Close”.

CUSTOMER: JOBS

Creating Customer:Jobs

1. Display the Customer:Job list by clicking on the Customer List icon or choosing “Lists” then Customer:Job.

2. Choose “New” from the “Customer:Job” menu button in the bottom left corner of the “Customer:Job List” window.

3. You will now be in the “New Customer” window.  In the “Customer” field, enter the name of the customer as you’d like it to appear on your “Customer:Job List”.

♣For example, if the customer is Joan Green and you want the list to show last names first, enter Green, Joan.

4. Complete the “Address Info.” Tab, which is the tab that first appears in the “New Customer” window.  The “Address Info.” Tab holds contact information about the customer.

A. Enter the customer’s first and last names, along with their middle initial and salutation or title (Mr./Mrs./Dr.).

B. In the “Bill to” section, complete the customer’s billing address (QuickBooks has partially filled in the address based on what you’ve entered so far). Enter the address as you want it to appear on printed invoices, checks, and other forms.

· Note:  The address information you enter can be exported for mail merge. If you use mail merge, be sure to include in the last line of the address the two-letter state abbreviation and the zip code. This ensures that the address will print correctly in mail merge documents.

C. In the “Ship To” field, if the customer has a separate shipping address, enter the address as you’d like it to appear on printed invoices and other forms. If the shipping address is the same as the billing address, click “Copy” to copy the billing address to the “Ship To” field.

D. Enter the fax number, phone number, alternate phone number, and alternate contact person in the “FAX”, “Phone”, “Alt. Ph.”,  “Alt. Contact” , and “E-mail” fields.

5. Click on the “Additional Info.” Tab and fill in the information fields you see there.  The “Additional Info.” Tab holds credit, sales tax, and other information about the customer.

A. In the “Account” field, enter the name or number of the account you want to associate with this customer.

· Note:  An account number is required if you want to set up this customer as an online payee. The payee uses this number to identify you.

B. Enter a type in the “Type” field.  This is a word or phrase that categorizes this customer for your reports. From this drop-down list, you can choose a customer type you have already set up, or you can enter a new customer type and have QuickBooks add it to the list.

· For example, a building contractor might use customer types to record a client’s market segment: residential, commercial, industrial, etc.

♣Once you have assigned a customer type to each customer, you can create reports that provide useful information about your customers in terms of how you have categorized them.

B. In the “Terms” field, fill in the specific set of payment terms you would like to

apply to this customer.  When you write an invoice to the customer, QuickBooks uses the terms to calculate when the invoice is due and, if you specified a discount for early payment, when the customer is entitled to the discount.

· For example: 2% 10 Net 30 means “2% discount if paid within 10 days, net due in 30 days” if the terms are standard terms, or “2% discount if paid by the 10th of the month, net due by the 30th of the month” if the terms are date-driven terms.

D.
In the “Rep” field, fill in the sales person, or rep, that typically handles 

the services provided to this customer.  If this field is not applicable, you can leave it blank. In the “Credit Limit” field, enter the credit limit that the customer has with your company. QuickBooks remembers the limit and warns you when the customer is about to exceed the limit.

E. The “Opening balance… as of” field has already been established for you, so you need to enter no further information here.  This field is only used when you are setting up the company.

F. Click in the “Customer is taxable” checkbox to make a check appear in the checkbox if you charge sales tax to this customer.  When you select this checkbox, QuickBooks automatically calculates sales tax for each taxable item you sell to this customer. QuickBooks uses the sales tax rate specified in the “Tax Item” field.  If you do not charge sales tax to this customer, unclick the box  so a check does not appear in the box.

G. In the “Tax Item” field, specify the sales tax rate you want QuickBooks to use to calculate sales tax when you sell taxable items to this customer. If the rate shown is incorrect for this customer, choose the correct rate from the drop-down list.

H. (Optional) If the customer has a resale number, enter the number in the “Resale Number” field. This field is for your information only so what you enter here will not affect your reports or how sales tax works in QuickBooks.

I. Fill in the “Custom Fields” information.  If you have set up any custom fields for the customer, they appear here on the “Additional Info” tab. You can fill in any or all of these fields that apply to the customer.  These are used to setup additional information fields that you may want for your vendors.  If custom fields have been set up for vendors then you will see the fields for each vendor.  These additional fields can be used to print or filter on reports.  An example of a custom field might be an birthday’s.

6. Fill in the “Job Info” tab.  The “Job Info” tab lets you enter job-related information when you are performing a single job for a customer. Use the “Job Info” tab when you don’t want or need to set up multiple jobs for a customer in your Customer:Job list.  If you are going to be doing multiple jobs for a customer you want to set the job up separately.  

♣To do this, leave the “Job Info” tab blank.  Highlight the customer you want to     set the job up for.

♣Click the “Activities” button at the bottom of you screen and select “Add Job”.

The “Address Info” tab will fill in the information from your customer that you have previously filled in.  You can adjust any information that may have  changed for this particular job (for example, the contact name may be different than that of the original Customer:Job.).  

Follow the rest of the instructions to fill in the “Job Info” tab.  

7. In the “Job status” field choose from the drop-down list, the status (Pending, Awarded, etc.) that best applies to this job.  Job status information is for your records only.  It gives you a way to keep track of each job. When you create a job administration report, QuickBooks Pro includes the status of each job on the report. You can also see the status of each job on the Customer:Job list.

♣Note: When a job’s status changes, you must edit the job record and change the status yourself. QuickBooks Pro does not do this for you.

8.  In the “Start date” field, enter the date you started the job.

♣The start date (along with the projected end and end dates) helps you track how long each job takes, and how well you estimated the length of a job. When you create a job administration report, you can add to the report columns that show the start date, your projected end date, and the actual end date for each job.

♣Note: When the date changes. You must edit the job record and change the date yourself. QuickBooks Pro cannot change the date for you.

9. In the “Projected end” field, enter your projected completion date for the job.

♣Note: When the date changes. You must edit the job record and change the date yourself. QuickBooks Pro cannot change the date for you.

10. In the “End date” field, enter the date of completion once the job is finished.

11. In the “Job description” field, enter a short description of the job.  The descriptions you enter will appear on job administration reports. When you enter a job description, enter information that will be useful to you when you see the job listed among other jobs in the report. (For example, if you have performed several jobs for the same customer, you could use the job descriptions to help you distinguish the jobs from each other.)

♣Note: If you want to write a longer description of the job, or if you want to jot down notes while the job progresses, use the job’s Notepad.

12. In the “Job type” field, enter a word or short phrase to classify the job. This helps you to classify your jobs so you can group and subtotal similar jobs on your reports. By using them, you’ll be able to determine which kinds of jobs are the most profitable for your business.  (Customer types can be used independently of job types to help you classify your jobs and clientele.)

13. Record the customer by clicking “OK” if you are done entering new Customer:Jobs or “Next” if you would like to enter another Customer:Job.

DEPOSITS

Recording a Deposit Received Against an Invoice

When you receive a payment on an invoice you’ve sent to a customer, use the “Receive Payments” window to apply the payment to the invoice. 

1. Display the “Receive Payments” window by choosing “Customer” and then “Receive Payments”.

2. Fill in the “Customer:Job” field at the top of the “Receive Payments” window by using the drop-down list and clicking on the name you need.  If the payment is for a particular job on your Customer:Job list, make sure you choose the job as well as the customer’s name in the Customer:Job field.  

3. Press the tab key to move into the “Date” field.  QuickBooks automatically displays the current date.  You should make sure the date is the same date that you are making the deposit to the bank.

4. Press the tab key again, to move into the “Amount” field.  Enter the amount of the payment.

5. Press the tab key to move into the “Pmt Method” field, and either write in the payment method of the payment you are entering (cash, check, Visa, etc.) or use the drop down list to choose the payment method.   

6. If the payment you have received is a check, you should enter the check number in the next field you tab down to which is the “Check No.” field.

7. In the “Memo” field, you should enter anything you would like to appear on the General Ledger associated with this payment.  Typically, people like to enter the invoice number to which this payment is being applied, in this space. 

8. If this is the first time you are entering a customer payment, indicate whether you want QuickBooks to group this payment with other undeposited funds, or deposit it directly into a bank account.  (You can choose whether you would like to “Group with other undeposited funds” or “Deposit to checking” by clicking the button next to whichever is your choice for this payment.  Group with undeposited means that you can group all the deposits for the day so that only one total entry is made to the Checking account.  This method makes reconciling bank account much easier (suggested method).  If you use Deposit to checking it deposits each individual check into checking separately.  If you deposit a lot of checks it is easier to do the bank reconciliation if you use Group to undeposited funds.  The only thing is that you have to remember to go into make deposit and record the deposit so that the amount is moved to checking when it is deposited.  Most businesses have a standard that all payments are put into one or the other category, but QuickBooks gives you this option for each payment you enter.)

9. At the bottom of the “Receive Payments” window you will see a box with eight columns in it, which allow you to distribute or redistribute the payment.  These boxes contain your invoice information for this Customer:Job, and are automatically filled in when you enter the Customer:Job name at the top of the window.  Normally, QuickBooks is set to apply the payment to the oldest invoice first, then to the next oldest, and so on.  If you want to distribute the amount of the payment differently, do the following:

♣You can change this amount by just clicking the column and entering the amount that you want applied to each particular invoice.

♣Note: Each time you select an invoice, QuickBooks automatically inserts the amount to be applied to the invoice in the Payment column.  When the undistributed amount of the customer’s payment is greater than the amount due, QuickBooks pays the invoice in full.  When the undistributed amount is less than amount due, QuickBooks applies the entire amount to the invoice, leaving a balance due on the invoice.

10. Record the payment by clicking “Save & Close” if you are done entering payments, or by clicking “Next” or “Save & New” if you will be entering more payments

♣Note: If you received one payment that covers multiple jobs, you’ll need to apply the appropriate amount of payment to each job separately.

11. Then you need to go to “Make Deposits” if you use group to undeposited funds.

DEPOSITS

Receiving payments towards a statement

When you receive payment for a statement you’ve sent to a customer, you use the Receive Payments window to record the payment.  You cannot enter customer payments directly in the customer or A/R registers, you need to apply the amount against the proper invoices.

To record this payment, you should follow the instructions under “Recording an Invoice Payment”.  

Depositing non-sales receipts.   

You should only enter deposits that are not associated with an invoice in the system here.
1. From the Banking menu choose Make Deposits.

2. If QuickBooks displays the Payments to Deposit window, click the ones you’d like to deposit now, and then click “OK”.  The payments shown here are those that you entered in the “Receive Payments” or the “Enter Cash Sales” windows, or they are from “Payment” items you entered on invoices or other sales forms.  If when in those functions, if you clicked the Deposit to Checking field, you will not see this window, and QuickBooks will take you directly to the Make Deposits window.  You will be using the “Make Deposits” window to select the account into which you want to deposit the payments selected in the Payments to Deposit window.

♣Note: If you are not going to deposit any of the payments now, you can skip this step by clicking just clicking OK.  (There should be no check marks next to any of the deposits listed in this window if you are not making the deposit now.)  This will open the Make Deposits window.

3. In the Make Deposits window, select the account you’d like to deposit into.

4. Enter the date that the deposit was made (or is being made) in the Date field. (This should be the date it is deposited in the bank account).

5. Click anywhere below the last payment in the list.

♣Note:  If the list is full, click anywhere in the list and press Ctrl+Ins to add another entry.

6. In the Received From column, enter the name of the person or vendor from whom you received the money.

♣Note:  If you are entering a refund from a vendor, enter the vendor name.  If this refund is for the return of items entered on a bill credit, enter the Accounts Payable account in the From Account column.  If the refund is for a discount or overpayment, enter the expense account of the original expense in this column.

7. In From Account, enter the account where you want to track the money.

8. Enter a memo, the check number (if you received a check), and the method of payment (check, Visa, etc.).

9. Enter the amount.

10. (Optional)  If you use classes, enter the class for this deposit. 

11. Indicate whether you are getting cash back.

12. Click “Save & Close” if you are finished entering the deposit, or “Next” or “Save & New” if you are going to enter another deposit.

Viewing a List of Payments Included in a Deposit

You can create a report that shows you a list of all deposits and the payments included in each deposit.

1. From the Reports menu, choose Banking, and then Deposit Detail.

2. You can use “QuickZoom” to go directly to the payments associated with a deposit.  Use your mouse to point to the payment you would like to see.  When you are over a payment that can use “QuickZoom” the mouse turns into a magnifying glass.  When it is in this shape, double-click it and QuickBooks takes you directly to the payment associated with the deposit, so you can see it in detail.

Suggestion:  Print the deposit report when entering the deposit.  Click on the print in the make deposit window and print detail report without deposit.

EDITING

Editing online account information

There are two ways to edit your online account information.

♣Use the Chart of Accounts Edit menu.  If you want to change the name, account number, etc., use the chart of accounts Edit menu.

1. From the Lists menu, choose Chart of Accounts.

2. Select the account you want to change.

3. From the Account menu button at the bottom of the window, choose Edit.

4. Click the Online Info tab.

5. Change each field as necessary in the Edit Account window.

6. Select or clear the online account access and online payment checkboxes.

♣Note:  Clearing the online account access and online payment checkboxes does not result in your online services being turned off at your financial institution.  However, if you clear both checkboxes, you will not be able to use this account for online services within QuickBooks.  To turn off online services and no longer be charged service fees, you must contact your financial institution.

7. When you’re finished making changes, click OK.

♣Start from the Online Banking Setup Interview

1. From the Banking menu, choose Set Up Online Financial Services and then choose Setup Account for Online Access.

2. In the Online Banking Setup Interview, click Enable Accounts.  Select your financial institution and then click Next until you reach the Review Account Information window.  Make any changes to the account information (or enable an existing QuickBooks account).

Editing or Changing Job Information:

Once you have set up a job for a customer, you can add to or edit the information as needed (or as the job progresses).  It is important to note that QuickBooks does not automatically update a job’s status, you must change the information yourself.

1. From the Lists menu, choose Customer:Job List.

2. If the list shows one or more jobs under the customer’s name, highlight the job you want to edit and choose Edit from the Customer:Job menu button.

3. If there are no jobs under the customer’s name, select the customer, choose Edit from the Customer:Job menu button and then click Job Info.

4. If you want to add a job to a customer, highlight the customer and choose Add Job from the Customer:Job menu button.

5. In the Edit window, enter any additions or changes you would like to make.

6. Click OK to record your changes.

♣Remember: QuickBooks is not a controlled accounting system so any transactions you make can be edited, changed, or deleted.

E-MAILING A QUICKBOOKS FILE

Open your email account to compose a message to the person you would like to send the file.

1. In most programs there are two ways to attach the file.  

A) You can click the paperclip symbol at the top of your E-mail window.  

B) You can choose “Insert” from the menu bar and then choose “File Attachment”.

2. In this case, the file that you will want to attach usually will be your QuickBooks working data file, which will consist of your company’s name followed by the extension .qbw.  (If you are asked for a backup the extension will be .qbb or an Accountant’s review file the extension will be .qba)

3. QuickBooks 2002 should be saved under the directory C:\program files\intuit\ QuickBooks Pro\[your company name].qbw (or whichever extension you are using).  You use the drop-down list in the “Look In” field of the “Insert Attachment” window to select the file name.  If you are having difficulty finding your file you can always select the “Find” feature on your “Start” menu bar, and choose “Files or Folders”.  Then type in your company name (or “ (. “ if you do not know the exact way the company name was saved for this file) and the extension of the file that you are sending.

4. After you have found the file, click “Attach” to attach the file to your E-mail and send it.  

♣Some E-mail systems will not let you send large files.  If this is the case, you will see a message that tells you the file is too large to send.  If you know how to zip a file, you can zip the file and then try to email it.  

                   SENDING A BUSINESS FORM BY E-MAIL

Sending an invoice by e-mail 

Display the invoice you want to send.

Click Send on the toolbar, then click E-mail Invoice.

In the Send Invoice window, check the e-mail addresses shown in the From and To fields.  The From field should show your company’s e-mail address.  The To field should show your customer’s e-mail address.

If other people should receive a copy of the invoice, enter their addresses in the Cc field.  Use commas to separate the addresses.

If needed, customize the cover note so that it is appropriate for your customer.  Click anywhere in the e-mail text and enter your changes.

If you want to give your customer the option to pay you online, make sure the “Allow online payment” checkbox is selected.

Click Send Now to send the invoice immediately.  Click Send Later to hold the invoice to be sent later, in a batch with other forms waiting to be sent.  The invoices are sent to Intuit and then e-mailed out through a secure site.

ESTIMATES

(The “Estimates” feature needs to have been turned on in the QuickBooks preferences to perform this function.

Creating an Estimate

1. From the Customer menu, choose Create Estimates.

2. Enter the name of the customer or job in the Customer:Job field.  You may either begin to type the name, or use the drop-down list to choose the name.

3. If class tracking is turned on in your company, enter the class information if you want to track this estimate by location, subsidiary, group, etc in the Class field.

4. Select a template for the estimate in the Template field.

5. Enter the line items in the columns at the bottom of the template.  You should enter them the same way you would enter the line items on an invoice (for detailed instructions refer to “Creating Invoices” in this instruction book).

6. Apply sales tax (if applicable) and click the customer is taxable if not checked.

7. Click Print to print the estimate.  

8. Click “Next” or “Save & New” if you would like to enter another estimate, click “Save & Close” if you are finished creating estimates.

Creating more than one estimate for a job

QuickBooks Pro allows only one estimate per job. If you want to prepare several estimates for a customer, here’s a way to get around the one estimate per job limit:

1. Make sure the estimates feature is turned on.

2. Set up a separate job for each estimate you want to write.  Name the jobs so that it is clear the jobs are all variants of the same job.  For example, “Kitchen Remodel 1,” “Kitchen Remodel 2,” etc.

3. Write an estimate for the first job, the second job, etc., filling out the fields according to the instructions in “Creating an Estimate” above.  Print each estimate to give to your customer.

4. When the customer accepts one of the estimates, do one of the following:

♣If you don’t need to keep a record of the other estimates, delete the other estimates and jobs.

♣If you want to keep a record of the other estimates, change the status of each job to Closed.  Changing the status to Closed allows you to keep a record of the estimate, and allows you to condense data in the future.  Only closed jobs can be condensed.  You can change the status by choosing “Lists” , then “Customer:Jobs” and editing it like you were editing Customer:Job information.  (Refer to the section on “Editing” for more detailed instructions.)

Creating an Invoice From The Estimate

When a customer has accepted your estimate and has agreed to pay a fixed amount (rather than for actual time and costs), you can turn the entire estimate into an invoice.  If you’ve already entered your actual time and expenses and assigned them to this job, you don’t need to create an estimate first.  Instead, create the invoice and click Time/Costs to include your time and expenses on the invoice.  

1.
Display the estimate 

♣From the Lists menu, choose Customer:Job List.

♣From the list, select the customer or job for which you wrote the estimate.

♣Right click on the job/customer and select Show Estimates.  If there are multiple estimates, double-click the estimate you want to review. 

♣A report will come up dispaying the estimates for the particular customer or job. 

2. Click the Create Invoice button at the top of the estimate form.  Specify the percentage of the estimate you want to include on the invoice.

3. When the invoice appears, edit the invoice as needed. 

4. Click Print to print the invoice now, or select the “to be printed” checkbox to print it with a batch of invoices later.

5. Click Next or Save & New if you will be entering another invoice or Save & Close to record the invoice and close the window.

ICONBAR

About the Iconbar

The Iconbar is a tool that is usually set up for you when the company is set up in QuickBooks.  However, it is a tool that can save you steps and time when you are working within QuickBooks.  You can set it up and customize it to suit your needs as you work with QuickBooks.

Customizing the Iconbar

1. From the View Menu, choose Customize Icon Bar.

2. If you want to add anything to the iconbar click on Add.

3. Click on the item you would like to add, select the icon and click OK

3. If you want to remove any icon, click on the item that you want to remove from the Current  navigation bar and click the delete button.

4. You can also change where the toolbar is located and how it looks on the screen.

5. To quickly add an opened window to your toolbar, go to View, and select “Add ‘name of window’ to Icon Bar”

6.  The choose the icon label, description and press OK.

INVOICES

Creating an Invoice

1. From the Customers menu, choose Create Invoices.  

2. Fill in the name of the Customer (or Customer:Job if you have more than one job for this customer) in the Customer:Job field.  You can either type the name in, or select the name from the drop-down list.

♣When you select the customer, QuickBooks automatically fills in the “Bill to”, “Terms” and “Due Date” fields with the default information you entered when you created the customer.  

♣If you enter a name in the “Customer:Job” field that is not already set up, QuickBooks will give you the “Customer:Job not found” window asking you to set up the customer.  Click “Set up” and follow the instructions for “Creating Customer:Jobs”.  If you choose “Quick Add” you are just adding the name to the customer list, and you will have to fill out all the information on the Invoice and also go back later and fill in all the information in the Customer:Job list.  Choosing “Cancel” will not let you write an invoice for this person at all.

3. (Optional)  If you want to track this sale by location, subsidiary, or group, enter the class information.  This field is only available to you if “Class Tracking” is turned on.    

4. Select a template from the drop-down list in the “Custom Template” field.  Depending on how your template is setup depends where all the following description are going to apply. 

5. The current date is automatically filled in for you in the “Date” field.  You can change the date by clicking on the calendar icon next to the date, and then clicking on the date you wish to enter.

6. The invoice number is also entered automatically in sequential order.  You can change this by clicking in the field and entering another number.  (QuickBooks will warn you about duplicate numbers if you have selected this option when you set the company preferences.)

7. In the columns at the bottom of the invoice screen- begin with the first column (“Item”) and enter the line items.  The line item area appears on the bottom part of the form. It is where you enter the merchandise or services you sold to the customer, as well as any discounts or payments at the time you made the sale.

A. In the “Item” column, choose an item from the Item drop-down list. Or, enter a name for a new item.

B. When you enter a new item name, QuickBooks prompts you to enter the information it needs to add the item to the “Item” list.  (See the instructions for “Items” for further detail on how to do this.)

C. Enter the quantity you sold, in the “Quantity” column, staying on the same line as the item is entered.

D. If you leave the “Quantity” field/column blank, QuickBooks assumes the quantity is one.

E. You may change, if needed, the “Description” and “Rate” fields/columns.  QuickBooks automatically fills in these columns with the information you entered when you set up the item.  The changes you make apply to this sale only.

Hints:

· To insert a line between two others

1. Click where you want to insert the new line.

2. From the Edit menu, choose Insert Line.

3. Enter an item in the new line and press Tab.

· To delete a line item

1. Click the line you want to delete.

2. From the Edit menu, choose Delete Line.

8. Continue to fill in line items with quantities, rates, and descriptions until you have entered everything for which you want to invoice the customer.

9. QuickBooks will calculate the amount using what you have entered in the “Rate” and “Quantity” columns and fill in the “Amount” column for that line item.

10. Apply sales tax (if applicable).  QuickBooks will automatically select the “Customer is taxable” checkbox if you marked the customer as taxable when you set up the customer’s record and the items are set up as taxable. The tax item shown (which is the State Rate) is the tax item you assigned to the customer (or the default tax if you have not assigned a tax item to the customer).  QuickBooks uses the tax item to calculate the tax.

♣If you don’t want to charge tax. Unclick the “Customer is taxable” checkbox in the bottom right corner of the window to clear it (there should be no check mark in the field).  Do not change the tax item shown in the “Tax” field at the bottom center of the window.

♣When an Item is taxable and the client is taxable, a little “T” will appear on the invoice on the same line as the item.  If you do not want to tax this item at this particular time, use your mouse to click the “T”  to make it disappear.

11. If you wish, enter a message for your customer in the “Customer Message” field in the bottom left corner of the invoice template.

12. Enter a memo in the “Memo” field at the bottom of the “Create Invoices” window.  The memo is a reminder to you, it does not appear on the printed form. It appears onscreen, on sales reports, and if you send reminder statements, it will print on reminder statements that include this invoice.

13. Click “Print” to print the invoice now, or click the “To be printed” checkbox so a check appears in the box, to print the form later. ** Remember you can e-mail faxes and invoices -  See page 35 which explains how to e-mail your forms and page 58 explains how to fax your forms.

14. Record the invoice by clicking “OK”.  If you would like to enter another invoice click “Next”.  

Customizing Invoices


Creating custom business forms is made up of two basic concepts, customizing and designing.  You customize the forms by specifying the fields and columns you want on the form in the Customize window.  You design the layout of forms with the Layout Designer window in which you can move and resize objects using the mouse.

1.   From the Lists menu, choose Templates.

2.
Select the template for the business form and choose Edit from the Templates menu button at the bottom.  To create a new template, choose New from the Template menu button instead or duplicate and modify an existing template.

3.   Enter your changes in the Customize window.

4.
If you are creating a new template, enter a name for the template in the Template Name field.

5.
If you want to change the position of fields or other elements on the form, click Layout Designer.

6.
Click OK to save your changes.

7.   To use the template, select the template name from the Template drop-down list on the form.

ITEMS

Understanding Items

QuickBooks Pro items represent services and products you provide, things you buy, and discounts you offer.  You use them when you create invoices, fill out checks, and create purchase orders, among other things.  While providing a quick means of data entry, items, more importantly, handle the behind-the-scenes accounting.  When you create an item you link it to an account, when the item is used on a form it posts an entry to that account and another to the appropriate accounts receivable, accounts payable, checking, or other account.

Item Types

QuickBooks provides ten different types of items to help you fill out sales and purchase forms quickly. 

Service – Services you either charge for or purchase.  Examples include specialized 

labor, consulting hours, and professional fees.

Other Charge – Miscellaneous labor, material, or part charges such as delivery charges, setup fees, service charges, copies, postage and mileage.

Inventory - Use inventory part items to represent materials or parts you buy, track as 

inventory, and then resell. Through inventory part items, you can keep track of how many items remain in stock after a sale, how many items you have on order, your cost of goods sold, and the value of your inventory. Note that QuickBooks does not track inventory through the manufacturing process.

Non-inventory parts – Goods you buy but don’t track, like office supplies, or materials you buy for a specific job that you charge back to your customer.

Subtotal - Used on sales forms, a subtotal item adds up the amounts of all the items above it, up to the last subtotal. You’ll need to create a subtotal item if you ever want to apply a percentage discount or surcharge to several items. 

Group
- Useful to quickly enter a group of individual items that you’ve already set up as single items on your list.

Discount –Subtracts a percentage or fixed amount from a total or subtotal.  Do not use this item type for and early payment discount.

Payment - Payment you received at the time you write an invoice.  A payment item 

reduces the amount owed on an invoice.

ITEMS

Sales tax item - Calculating a single sales tax.

Sales tax group - Calculating two or more sales taxes grouped together and applied to 

the same sale.

Creating Service Items

Service items can include professional fees or labor that you charge for or pay for. For example, you may charge clients for your consulting time, but pay for janitorial services. 

1. From the “Lists” menu, choose “Items List”.

2. From the “Item” menu button at the bottom, choose “New”.

3. In the “Type” field of the “New Item” window, choose “Service”.

♣Note:  You cannot change a service item to another item type once you have recorded the item.

4. Enter an item name or number in the “Item Name/Number” field.

♣What you enter here appears on the drop-down list of items when you are filling out a sales form or purchase order. Enter a name or number that will help you distinguish this item from all the others on the list.

5. If this item is a subitem of an existing service item, select the “Subitem of” checkbox and specify the parent item’s name.

6. Enter a description in the “Description” field.  This description will display on the sales and purchase forms.

7. Enter a rate for the service in the “Rate” field.  The amount can be either a flat fee or an hourly rate. Leave the field blank if this rate varies. If you purchase this service, enter the vendor’s rate. If you sell this service, enter the rate you charge your customers.

8. (Sales only) If you don’t charge sales tax for this item, choose Non from the sales tax code field.

9. Click “Custom Fields” to fill in any custom fields that apply to this item.

10. In the “Account” field, enter an income account for sales or an expense account for purchases.

11. Click “Ok” to record the item and leave the “New Item” window, or “Next” to close this item and enter another.

ITEMS

To Create an “Other Charge” Item for Reimbursable Charges

1. From the Lists menu, choose Item list.

2. From the “Item” menu button in the bottom left corner of the “Item List” window, choose “New”.

3. In the “Type” field of the “New Item” window, choose “Other Charge”.  Remember that once you create the item you will no longer be able to change the “type” you have assigned to that item.
4. Enter and item name or number.  What you enter here will appear on the drop-down list of items when you are filling out a sales form, purchase order, or entering expenses on a check. Enter a name that will help you distinguish this item from all the others on the list.

5. If this item is a subitem of an existing other charge item, select the “Subitem of” checkbox and specify the parent item’s name.

6. Click on the “This is a reimbursable charge” checkbox so that an “X” appears in the box. 

7. Fill in the “Purchase Information” fields. Typically, small companies will be using this feature to enter items such as mileage, postage, and copies.  In this case you will not be marking the item up, so all the Purchase fields can be left blank except for the “Expense Account” field.  To fill in this field you should choose “Reimbursable Expense- Income Account”.  

If you purchase parts or other items that you then resell to your customer at a profit to your company, you can use the following instructions to fill out the window properly.

A. (Optional) Enter a description in the “Description on Purchase Transactions” field. What you enter here appears in the “Description” column of checks, bills, credit card charges, and purchase orders when you buy or order the item.

B. Hit the tab key to move to the next field.

C. In the “Cost” field, enter the cost you expect to pay when you buy or order this item. You can change the cost at the time you buy or order the item.

D. Enter the Expense Account you would apply this to when you receive a bill from the vendor in the “Expense Account” field.

E. (Optional) Enter a description in the “Description on Purchase Transactions”. What you eneter here appears in the “Description” column of the purchase form when you buy the item.  Your description may be up to three lines in length.  If you need to, you can edit the dexcription when you are filling out a sales form.  

F. (Optional)  In the “Preferred Vendor” field, choose or enter the name of your preferred vendor for this item.

8. Fill in the “Sales Information” fields. As mentioned in step 6, small companies typically will be using this feature to enter items such as mileage, postage, and copies.  In this case you will not be marking the item up, so all the “Sales” fields can be left blank except for the “Income Account” field.  To fill in this field you should choose “Reimbursable Expense- Income Account”, which is the same account you entered in step 6 above.  

If you purchase parts or other items that you then resell to your customer at a profit to your company, you can use the following instructions to fill out the window properly.

A. (Optional) Enter a description in the “Description on Sales Transactions”.  What you enter here appears in the “Description” column of the sales form when you sell the item. Your description may be up to three lines in length. If you need to, you can edit the description when you are filling out a sales form.

B. In the “Sales Price” field, enter the sales price you want to charge your customers for the item.  This is typically a number greater than your purchase cost. If the sales price varies, leave this field blank. (You’ll enter the price directly on the sales form.) 

C. If this item is taxable, select the tax category from the drop down list. If it is not taxable, choose “Non Taxable Sales” from the same list.

D. In the “Income Account”, enter the income account that you want to register the receipt of payment that you will receive when you bill your customer for the cost.

9. Click “Custom Fields” to fill in or create any custom fields so you can enter more information associated with this account.

10. Click “Ok” to record the item.

Creating Inventory Items

Inventory tracking must be turned on for you to perform this function.  It is important to note that you should not create separate inventory part items for sales and purchases.  You must use the same inventory part item on both sales forms and purchase orders to keep the inventory accurate.  

1. From the “Lists” menu, choose “Items List”.

2. From the “Item” menu button at the bottom of the window, choose “New”.

3. From the “Type” field drop-down list, choose “Inventory Part”.

4. Enter an item name or number in the “Item Name” field.  What you enter here appears on the drop-down list of items when you are filling out a sales form or purchase order.  Enter a name or number that will help you distinguish this item from all the others on the list.

5. If this item will be a subitem of an existing item, select the “Subitem of” checkbox and use the drop-down list specify the other item’s name.  Refer to “Creating Sub-Items” for more information.

6. Fill in the Purchase Information fields. 

♣“Description on Purchase Transactions”  - What you enter here appears in the “Description” column of checks, bills, credit card charges, and item receipts when you reorder the item.  If you need to, you can edit the description when you are filling out a purchase order.

♣“Cost” (Optional)  - Enter the cost you expect to pay when you order or buy this item. You can change the cost at the time you purchase the item.  The cost of a built inventory assembly item is always the sum of component costs.

♣“COGS Account” - Choose a different cost of goods sold account if you don’t want to use the preset account.  If this is an assembly item, this account can be different from the COGs account assigned to component items.

♣“Preferred Vendor” - (Optional) Select or enter the name of your preferred vendor for this item.  QuickBooks displays the preferred vendor on the stock status report and the physical inventory worksheet.

7. Fill in the Sales Information fields for information you show to customers. 

♣“Description on Sales Transactions” - What you enter here appears in the “Description” column of the sales form when you sell the item.  If you need to, you can edit the description when you are filling out a sales form.

♣“Sales Price” - Enter your sales price for the item.  If your sales price varies, leave the field blank.

♣“Tax Code”- select the tax code which applies to this item 

♣“Income Account” - Choose an income account to track the income you earn from sales of this item.

8. Fill in the “Inventory Information” fields for easy reordering of stock. 

♣“Asset Account “ - Choose a different inventory asset account if you don’t want to use the preset account. QuickBooks uses this account to track the current value of your inventory.  If you use the same account for all your inventory part items, the balance of this account shows the total value of your inventory at any one time.

♣“Reorder Point” - Enter the quantity at which you want QuickBooks to remind you to reorder this item.  This information also appears on the stock status report.

♣“Qty on Hand” and “Total Value” - If this is an item you already have in stock, enter the quantity on hand and value as of the last time you measured your inventory.  Be sure to enter any sales or purchases of the item that occurred between the date you measured your inventory and today to ensure that QuickBooks’ record of your quantity on hand for the item is accurate.  If this is a new item that you are adding to your inventory, leave the “Quantity on Hand” and “Total Value” at zero.

♣“As of (date)” - If this is an item you are converting to an inventory part item from a non-inventory part or other charge item, the date you enter must be a date that is after the date of the last transaction that uses the item.

9. (Optional) Click “Custom Fields” to fill in or define custom fields for this item.

10. Record the item by clicking “Next” if you would like to enter another item, or click “OK” to record the item and close the window.

Creating Non-Inventory Part Items

1. From the “Lists” menu, choose “Items List”.

2. From the “Item” menu button, choose “New”.

3. In the “Type” field of the “New Item” window, choose “Non-inventory part”.

4. Enter an item name or number in the “Item Name” field.  What you enter here appears on the drop-down list of items when you are filling out a sales form or purchase order.  Enter a name or number that will help you distinguish this item from all the others on the list.

5. If this item is a subitem of an existing non-inventory item, select the “Subitem of” checkbox and specify the parent item’s name.  See “Creating Subitems” for more instructions about creating sub-items.

6. Enter a description in the “Description” field.  This description will display on the sales and purchase forms.

7. Enter a rate for the item in the “Price” field.

8. (Sales only)  Select the tax code which applies to this item.  If you don’t charge sales tax for this item, choose Non from the sales tax code field.

9. Click “Custom Fields” to fill in any custom fields that apply to this item.

10. In the “Account” field, enter an income account for sales and an expense account for purchases.

11. Click “Next” to record the item and enter another one.  Click “OK” to record the item and close the window.

Creating subtotal items

Because QuickBooks calculates percentages only on the line above, you must use a subtotal item before calculating a discount or a charge that covers several items.

1. From the “Lists” menu, choose “Items List”.

2. From the “Item” menu button, choose “New”.

3. From the “Type” drop-down list, choose “Subtotal”.

4. Enter an item name in the “Item Name” field, such as “Subtotal.”

5. Enter the description that you want QuickBooks to put on your sales forms when you apply the subtotal into the “Description” field.

6. Click “Ok” or “Next” to record the item.

Creating Sub-Items

Subitems let you create a hierarchy of items so you can group information about similar items in sales reports and graphs.  Subitems are purely for your own convenience.  They look the same as items on sales forms and purchase orders.

1. In the “New Item” window, create the “parent” item (that is, the item that will have subitems) first.  If you won’t be using the parent item on invoices and sales forms, you can leave the rate or price of the parent item at zero.  You still have to assign an account to the item; however.  QuickBooks requires an account even if you don’t plan to sell the item.

2. Create the subitems: An example of a service sub-item might be “consulting” as the “parent” item, then “framework consulting”, or “drafting consulting” as the sub-items.

♣Begin as if you were setting up this item in the usual fashion.

♣Each subitem must be the same type as its parent item.

♣To make the item a subitem, select the “Subitem of” checkbox and choose the name of the parent item.

3. Once you have clicked the checkbox you will be able to see and use the drop-down list in the “Sub-Item” field of the items you have already created.  Highlight the item that you want the item you are creating now to be a sub-item of.

4. After completing all the information according to the instructions relevant to the type of item it is, click “Ok” or “Next” to record the item.

Creating Group Items

If you often enter the same group of items when you record a sale or purchase, you can set up the items as a group item.  Instead of entering each item individually, when you fill out a form, you enter the name of the group item.  QuickBooks then fills in the details for the items in the group.

Group items let you track the items you sell in greater detail. For example, a construction firm that remodels houses could set up a group item that lists the significant components of a remodeling job: lumber, carpentry hours, markup, etc.  Sales reports for the company would then show income broken down by each component instead of a single lump sum for all remodeling jobs.

If you need to track a lot of detail about your items but you also want to give your customers simple, uncluttered invoices, you can use group items to do both.  You can set up a group item so that the printed version of an invoice reduces a group item to a single line item and one amount.  Yet when you view the invoice on your screen, you see a separate line entry and amount for each item in the group.

Group items also give you a way to enter a great amount of line item detail quickly. On a sales or purchase form, all you have to do is enter the name of the group item and QuickBooks fills in all the details about the items in the group for you.

1. From the “Lists” menu, choose “Items List”.

2. From the “Item” menu button, choose “New”.

3. From the “Type” drop-down list, choose “Group”.

4. In the “Group Name/Number” field, enter a name or number for the group item.

5. Enter a description of the group item in the “Description” field.  This description will appear on sales forms. 

6. (Optional) Select the “Print items in group” checkbox if you want your customers to see a list of the individual items and their amounts on your printed forms.  Leave this checkbox clear if you don’t want the details of the group to appear on your printed forms.  (You’ll still see the details when you view the form onscreen.)

7. In the “Item” column, select the items that you want to include in this group by using the drop-down list of items that are already set up.

8. In the “Qty” column, enter the quantity you want QuickBooks to enter for each individual item when you use the group item on a form.  If you do not enter quantities, QuickBooks assumes that the quantity of each item is 1.  You can always change the quantities when you enter a sale or purchase. 

9. Click “Custom Fields” to fill in any custom fields that apply to this item.

10. Record the item by clicking “Next” or “OK”.

Creating discount items

A discount item applies a discount, either a percentage or fixed amount, to the preceding line on the sales form.  You do not need a discount item for discounts you give for early payment.  You can have QuickBooks calculate these discounts for you when you receive payments from customers.  If you are applying the discount to more than one item, you must first use a subtotal item and then apply the discount to the subtotal.

1. From the “Lists” menu, choose “Items List”.

2. From the “Item” menu button, choose “New”.

3. In the “Type” field of the “New Item” window, choose “Discount”.

4. Enter an item name, such as “Discount” in the “Item Name” field.

5. Enter the description in the “Description” field that you want QuickBooks to put on your sales forms when you apply the discount.

6. Enter the discount amount or percentage in the “Amount or %” field:

♣If the discount is a percentage, include a % sign.  For example, 5% tells QuickBooks to multiply the previous line by .05.

♣If your discount amounts vary, you may want to leave the Amount field blank and enter the amount directly on your sales forms.

7. Enter the account you use to track discounts you give to customers.  You can use either an expense account or an income account.  When an income account tracks discounts on sales, the account is often called a “contra-income” account.

8. Select the tax code which applies to this item.

♣If you select a taxable code, the discount you specify on the taxable sales will be applied before the sales tax is calculated.  If you select a non-taxable code, the sales tax will be applied after the tax is calculated.

9. Record the item by clicking “Next” or “OK”.

Creating payment items

A payment item subtracts the amount of a customer payment from the total amount of an invoice or statement.  You need a payment item when you receive a partial payment toward the amount of an invoice or statement at or before the time you create the invoice or statement.

If you receive full payment at the time of the sale, use a sales receipt form instead of an invoice with a payment item.

1. From the “Lists” menu, choose “Items List”.

2. From the “Item” menu button, choose “New”.

3. From the “Type” drop-down list, choose “Payment”.

4. Enter an item name, such as “Pmt by check” or “Pmt by cash” in the “Item Name” field.

5. Enter the description that you want QuickBooks to put on your sales forms when you use the payment item into the “Description” field.

6. From the “Payment Method” drop-down list, choose the appropriate method.

♣If you choose a payment method, you can group the money you receive by payment method when you deposit it (all checks in one deposit, all American Express charges in another deposit, etc.). Simply create a separate payment item for each payment method your customers use.

7. Indicate how you want QuickBooks to deposit customer payments:

♣If you want to group it with other payments to be deposited later, click “Group with other undeposited funds.”

♣If you want it deposited directly to a bank account, click “Deposit To” and enter the name of the bank account where you would like QuickBooks to deposit the payment.

8. Record the item by clicking “OK” or “Next”.

Creating Tax Items

Use a tax item on your sales forms to calculate the sales tax on a sale or to identify non-taxable items.  A tax item represents a single tax that you collect at a specified rate and pay to a single agency.

1. From the “List” menu, choose ”Items List”.

2. From the “Item” menu button, choose “New”.

3. From the “Type” drop-down list, select “Sales Tax Item”.

4. Enter a tax name in the “Tax Name” field.

5. Enter a description in the “Description” field that will describe this sales tax on your sales forms.

♣The description prints on your sales forms after the final line item.  You cannot edit it on the forms themselves.  If you want to edit sales tax, you will need to edit the tax, as you would edit an item.

6. Enter the tax rate in the “Rate” field.  QuickBooks assumes the rate is a percentage. For example, enter 7.25 if the rate is 7.25%.

7. Enter the tax agency to which you pay the tax in the “Tax Agency” field.

8. Record the item by clicking “Next” or “OK”.

♣If you collect sales tax at more than one rate, or if you pay sales tax to more than one agency, then you must set up a separate tax item for each tax you collect for each agency. 

♣If you charge your customers a combination of taxes, you’ll want to set up tax groups.

Setting Up Tax Groups

Even though you may be charging your customers a combination of local taxes and a state tax, they’re used to seeing only one sales tax line and rate on sales forms.  A tax group lets you track each tax separately, yet show only the total sales tax on your sales forms.

When you use a tax group on a sales form, QuickBooks calculates each tax individually, then adds the individual taxes together to get the total tax.  Because QuickBooks rounds the individual tax amounts to the nearest cent, the total for tax group may be slightly different than the total you would get if you combined the rates of the individual taxes and applied the single rate to the sale.  Don’t worry about this discrepancy; QuickBooks calculates and reports each individual tax amount correctly.

1. From the “Lists” menu, choose “Item List”.

2. From the “Item” menu button, choose “New”.

3. From the “Type” list, select “Sales Tax Group”.

4. Enter a name for the group in the “Group Name” field.

5. Enter a description in the “Description” field to describe this sales tax on your sales forms.

♣The description prints on your sales forms after the final line item.  You cannot edit it on the forms themselves.  If you want to edit sales tax, you will need to edit the tax, as you would edit an item.

6. In the “Tax Item” column, choose the single taxes that make up this group from the drop-down list.  When you press the tab, QuickBooks fills in the rate, tax agency, and description of the single tax you have selected.  Continue to add single taxes to the group until all the correct taxes are included.

7. Record the item by clicking “Next” or “Ok”.

MAKING A JOURNAL ENTRY

The general journal entry is a double bookkeeping entry.  You need to know the debit account and the credit account that should be adjusted in the entry.

The General Journal Entry window is typically for accountants who prefer to enter certain transactions in a general journal.  Usually, accountants will make general journal entries when working with an accountant’s review copy.  If you are not an accountant, you might use this window to transfer amounts from one income or expense account to another or from one class to another.

1. From the “Banking”” menu, choose “Make General Journal Entry”.

2. You can change the date in the “Date” field if you need to.

3. Fill in the entry number in the “Entry No.” field.  This number will appear on reports that include this general journal entry.  You can use alpha also.

4. Check the adjusting entry checkbox, as appropriate.

5. In the detail area that includes “Account”, “Debit”, “Credit”, “Memo”, and “Name”, enter the distribution lines.  You need to select the accounts that need to be debited and credited.  

A.  In the “Account” column, enter the first account in your transaction.

B. Enter the debit or credit amount for the account you entered.

C. (Optional) Enter a memo about the amount in the “Memo” column.  The memo appears on reports that include this general journal entry.

D. Enter the customer, vendor, or employee or other name associated with the amount in the “Name” column.  If the account is an A/R or A/P account, you must enter a name.

E. (Optional) If you enter an expense account and a customer or job, you can make the amount billable to the customer.  To not bill a customer for an expense, click the billable icon to put an X through it.

F. (Optional) Assign a class to the amount if the class option was set up for your company.

G. Continue to enter distribution lines until the transaction reaches a zero balance (the total in the “Debit” column equals the total in the “Credit” column).

6. To record the journal entry:

A) To record and then enter another journal entry, click “Next” or “Save & New”.

B) To record and close the window, click “Save & Close”.

Printing a Journal Entry

You can now print right from the Journal Entry screen. Click the print button.

MEMORIZING
Memorizing a Report for Reuse:

1. After you have customized any report, click “Memorize” on the report buttonbar at the top of the window.

2. If it is a completely new memorized report, enter a title for the report in the “Memorize Report” window.

3. If you have recalled a previously memorized report and changed it, indicate whether you want QuickBooks to replace the earlier report under the same name, or create a new memorized report under a new name.  If you want QuickBooks to replace the earlier report, click “Replace”.  If you want QuickBooks to memorize this report under a new name, click “New” and then enter a name in the “Memorize Report” window.

4. If you want to assign the report to a memorized report group, select Save in Memorized Report Group, then choose the group from the drop-down list

5. Click OK.

Recalling a memorized report

1. From the “Reports” menu, choose “Memorized Reports”.

2. In the “Memorized Report List” window, select the report you want to view.

3. Click the “Display” button at the bottom of the window.

Renaming a Memorized Report:

1. From the “Reports” menu, choose “Memorized Reports” and then choose Memorized Reports list.

2. In the “Memorized Report List” window, select the report you want to rename.

3. Choose “Edit” from the “Memorized Reports” buttonbar.

4. Enter the new name of the report in the “Memorize Report” window.

5. Click “OK” when you have given it the name you want.

RECONCILING

Reconciling your Bank account

Make sure your QuickBooks records agree with the checking, savings, and money market account and credit card financial statements your regularly receive.

1. From the Banking menu, choose Reconcile to display the Begin Reconciliation window.

2. In the Account to Reconcile field, enter or select the account you want to reconcile.

3. In the Statement Date field, enter the date of the bank statement you are trying to reconcile.

4. Compare the opening balance amount shown on your statement with the amount shown in the Beginning Balance field in the Reconcile window.  If the opening balance is different, go to the Reports Menu and select Banking and the Reconcile  discrepancy report.

5. Find the ending balance on your statement and enter it in the Ending Balance field.

6. Enter any service charge or interest earned:
A) If the financial statement shows a service charge or interest that you have not yet entered into your QuickBooks records, enter those amounts into the Service Charge and Interest Earned fields.

B) In the Account field for service charges, enter the expense account you use to track service charges, usually bank service charges. In the Account field for interest, enter the income account you use to track interest income.

7. Click Continue to open the Reconcile window for the account you’ve chosen.  The reconcile window displays a list of checks and payments, plus a list of deposits and other credits.  Using your latest bank statement, check each of the entries to make sure they match.

8. When you find a transaction in the Reconcile window that matches a transaction on the statement, click the transaction to mark it as cleared.

9. For each transaction you mark, verify that its amount matches the amount listed on the statement.

10. If some amounts don’t match, or if you find transactions that contain other errors, correct the transactions.

11. If you find a transaction on your statement that is not shown in the QuickBooks list of uncleared transactions, enter the transaction now.

12. When you’ve finished marking the transactions, look at the difference amount in the bottom right corner of the Reconcile window:

A) If the amount is 0.00 click Reconcile Now.  You’ve reconciled the account with the statement.  At this point, you can have QuickBooks print a reconciliation report.

B) If the amount is not zero, your account does not balance for the period of time covered by the statement, and you need to correct the difference.  If you cannot find you difference click cancel and notify your accountant.  NOTE:  If you click Reconcile Now when the account is not in balance the adjustment that QuickBooks will make will be applied to the opening balance equity account.

13. After reconciling your account, you should print both the summary and detail.  

REPORTS

About Reports

QuickBooks provides many reports you can use to evaluate and see the inner workings of the accounting of your business.  These reports include: Financial reports, reports for your accountant, budgeting, accounts receivable, sales, customers and jobs, the items you sell, job costing and time tracking, accounts payable, bills, purchases, and expenses, inventory, vendors, taxes, payroll operations, and employees.  To see a list of the reports available, under “Reports” on the main iconbar select Report Finder and you will see every different type of report , then select the report you would like to create.  QuickBooks will display the choices of reports you have in that area.

QuickBooks also allows you to further customize your reports once you have created the base report through customize and filter features.  You can also export report information to Microsoft Excel and further customize or even combine reports.  With all the features QuickBooks provides to you, you can create practically any report your company would need.

Example:  To Create a Deposit Report Which Totals by Day

1. Go to Reports on the Top toolbar

2. Select “Custom Transaction Detail Report”.

3. In the Columns Window uncheck the following items: Memo, Account, CLR, Split, Balance

4. In the “Total By” area, change from Total Only to Day by clicking the down arrow to the right of the line, then click on Day

5. Next click the Filters button in the window

6. Click on Account in the Filter box, then on the account line change from All Accounts to Selected Accounts.

7. Then click on Cash Account (checking, savings etc.) so that it becomes checked (or selected)

8. Click on the Header/Footer Tab

9. Change the report title to Deposit Report

10. Click OK to exit the window.

11. Click the Memorize button

12. QuickBooks will ask you for the report title. You can leave it as Deposit Report

13. Click OK

Whenever you need this report, go to Memorized Reports, under Reports on the top toolbar and double-click on Deposit Report.  You can change the date once you are in the report if you need to run the report for a specific time period     

   EXPORTING A REPORT TO MICROSOFT EXCEL
       This requires QuickBooks Pro and Microsoft Excel 97 or higher.

1 From the reports menu, choose the report or graph you want.
2 Click on Excel
3 Select whether you want to create a new spreadsheet or add the report as a new sheet in an existing spreadsheet.
4 You do not need to open Microsoft Excel. QuickBooks Pro will open the application for you when you export the report.

FAXING BUSINESS FORMS FROM QUICKBOOKS
You can fax forms, lists, and reports from QuickBooks if you have a fax modem and fax software.  A fax machine is not required.

1. Display the invoice or estimate

2. Choose Fax from the Send drop-down menu

3. In the Edit Fax information window, review the information shown in the From and To sections

The From section should show your company’s name, phone number, and fax number.  The To section should show the recipient’s company, name, and fax number

4. Check the fax cover note.  Change it if appropriate.

5. Click one of the following – Send Now or Send Later

*** REMEMBER YOU MUST HAVE FAXING CAPABILITIES SET UP ON YOUR     COMPUTER BEFORE THIS CAN BE DONE ***

SALES TAX

Sales Tax Liability Reports


You are going to want to print this report to use in filling out your sales tax report

1. From the “Reports” menu choose “Vendors and Payables” and then “Sales Tax Liability”

2. Print a copy of your “Sales Tax Liability Report” in order to help you fill out the Pennsylvania State Tax Return.

3. After you fill out the sales tax report you need to enter the 1% discount ( if you are paying on time) into the Sales Tax Payable Register in QuickBooks.
4. From the “Banking” menu choose “Chart of Accounts”.
5. Double-click on “Sales Tax Payable”.

6.  In the register enter the date you are paying the sales tax

7. Enter the Vendor: Pennsylvania Department of Revenue

8. In the Paid column enter the discount amount.  This amount is 1% of your total sales tax payable.

9. Click Record.

Sales Tax Report

You also want to create a Sales Tax Report detail listing the invoices and sales amounts that make up the total on the Sales Tax Liability Report. 

1. From the “Reports” menu choose “Vendors and Payables” and then “Sales Tax Liability”

2. Double-click on the “Total Sales Tax Payable” value to access your “Custom Transaction Detail Report”

3. Choose “Modify Report” from the toolbar

4. In the” Columns” menu uncheck the following: Memo, Account, Class, Clr, Split 

5. Next choose “Filters” from the toolbar

6. In the “Filter” menu select “Transaction type” and then select “Invoice”. This will allow the report to show only the invoices.

7. Choose “Format” from the toolbar and click the “Header/Footer” tab

8. Change “Report Title” to “Sales Tax Report” and click OK

9. Choose “Memorize” from the toolbar and click OK when QuickBooks asks to “Enter Memorized Report Name”.
10.  Print the new “Sales Tax Report” for backup to the Pennsylvania State Tax Return
Paying Sales Tax

1.   From the “Vendors” menu, choose “Sales tax…” and then choose “Pay Sales Tax”.

2.   If you have more than one checking account, choose the checking account from which you want to pay the tax.

3.   Check the date that QuickBooks shows in the "Show sales tax due through" field. If necessary, edit the date.

4.   In the detail area, select the tax agencies you want to pay:

(To select agencies individually, click in the “Pay” column.


(To select all the agencies, click “Pay All” Tax.


(To make an adjustment, click Adjust.

5.   If you want to make a partial payment to an agency, edit the amount that QuickBooks shows in the “Amt Paid” column.

6. Click OK.

STATEMENTS

Creating and Printing statements

1. Display the Select Statements to print window by choosing “Customer” and selecting “Create Statements”.

2. If your chart of accounts contains more than one accounts receivable account, QuickBooks will display the “A/R Account” field so you can choose the A/R account for the statements that you want to print.  If you only have one accounts receivable account, this field will not be available to you.

3. From the “Format” drop-down list, choose the template you want to use to print the statements.

♣If you want to create a new template for this printing job, choose Customize from the list.  When you finish setting up the template, QuickBooks selects it and lets you continue with printing.

4. Enter the beginning and ending dates of your billing period in the “Dates From” and “To” fields.

5. Enter the statement date in the “Statement Date” field.  This date appears on the top of the printed statements and in the “Billed Date” field of each customer’s register.

6. Choose the customers you want to print statements for in the “For Customers” buttons. 

♣Click “All Customers” to select all your customers.

♣Click “Selected Customers” to select only certain customers.  The “Choose” button will then become usable, click on it to select the customers.  Select the customers by clicking each Customer:Job name that you want to print a statement for.  To include all the invoices you sent to a particular customer, be sure to choose all the jobs you are performing for that customer.

♣Click “One Customer” to select one customer.  Use the drop-down list to select the customer.

♣Click “Customers of Type” to select only those customers who match a specific customer type.  Use the drop-down list to select the customer type.

7. Click “Don’t Print Statements That Have a Zero Balance” to omit statements for customers who are paid up.

8. If you performed more than one job for the customer(s) you selected and if you want QuickBooks to print a separate statement for each job, select “For each Job” under “Print Statement For”.  Otherwise, QuickBooks prints a consolidated statement for each customer.

9. Click “Preview” if you want to review the information that will appear on the statements.

10. Click “Finance Charges” to add finance charges to the statements.

11. Click “OK”.

12. In the “Print” window, check the printer settings for printing job.  Make any changes needed.

13.  If you want to print more than one copy of the statements, enter the number of copies in the “Copies” field.

14. Click “Print”.

TIME TRACKING

About Entering Time

QuickBooks Pro gives you two different ways to enter time directly into your company file.  Time tracking is only available in Pro or Premier versions.  You can enter:

· Single activities at the time they occur

· All the hours for each job on weekly timesheets

Both methods accomplish the same thing. 

When you make a single activity entry, QuickBooks Pro automatically records the entry on that person’s weekly timesheet. Likewise, if you fill in a weekly timesheet, QuickBooks Pro also saves each hourly entry as a separate, single activity entry. You can switch from one method to the other at any time.

About Weekly Timesheets

The weekly timesheet is most effective if you are entering several dates or several jobs at once.  A weekly timesheet shows the time spent by one person doing any number of activities for any number of jobs within a seven-day period.  The timesheet can only display one week at a time, but you can easily view the hours entered for other weeks.  You can change the start day of the week by going to preferences under Time.

Before tracking time on a weekly timesheet it is important to be sure that the following things are already set up within QuickBooks: 

Add names of all persons whose time you want to track to the appropriate QuickBooks lists (Employee, Vendor, or Other Names).  Also, set up the customers, jobs, and items for which time will be tracked.  Both of these things should already be done when the company is set up, and in the daily functions of QuickBooks before you will be entering time.

About Single Activities

Use a single activity entry if you want to time activities as you do them. Or, you can jot down the details of one day’s work as the day progresses. 

A single activity entry shows the time spent by one person doing a single activity for a single job on a single date. If you’re recording time spent on different jobs, you must make a separate entry for each job even if the same person performed all the work.

Use the Stopwatch to time activities as you do them. For example, an attorney could use a single activity entry to time or record time spent on the telephone with a client. He or she could start the Stopwatch upon answering the call, then stop it when the call is completed.
Filling in weekly timesheets

1. From the “Employees” menu or Customers menu, choose “Time Tracking” and then choose “Use Weekly Timesheet”.  

2. Enter the name of the person who performed the work and press your tab key.  Make sure you are using the name that is associated with “employee” type.  (As opposed to “vendor”, “customer”, or “other name”.)

3. If you have already made time entries for that person for that week, the entries appear on the timesheet.  You can add to or edit those entries.

A. If necessary, change the date range of the week displayed:

· To change to the next week, click “Next Week”.

· To change to the previous week, click “Prev Week”.

· To change to any other week, click “Set Date” and enter a date in the week you want to display.

4. In the “Customer:Job” field, which is the first column listed on the timesheet template, enter the customer for whom the work was performed. If you are tracking individual jobs as well, enter the customer name, a colon, and a job name.  You can also use the drop-down list to choose the customer or individual job.  Press the tab key to move into the column.

· Non-billable time: If you do not intend to invoice your customer for this particular activity, you still may want to enter the customer or job name. For example, if you spent the time correcting an error on a job, filling in the Customer:Job field gives you a record of your non-billable time for the job. You can display non-billable time on time reports.

· Overhead: If the time is truly overhead and has no association with any customer or job, then leave the Customer:Job field blank or you can setup your company has a customer.

5. Enter the name of the service item that matches the type of work the employee did for the customer/job that was just entered, in the next column, which is the “Service Item” field.  The item should be what you would want to invoice this customer in terms of the work the employee has finished.  Then press tab to move into the next column.

6. (You can only perform this step if Payroll is turned on.)  Change, if necessary, the payroll item that QuickBooks Pro enters in the “Payroll Item” field.

· For example, if you are recording sick time for a salaried employee, choose the “Sick Salary” payroll item.  You don’t have to worry about the employee’s actual salary or hourly rate when you choose a payroll item because you entered wage information for your employees when you set up the employees’ payroll record.

7. (Optional) In the “Notes” field, enter any additional information about this work and press tab.

♣Any notes you enter in this column can be printed on an invoice when you bill the customer for this time.  See the instructions for “Invoices” to learn how to do this.

8. (Optional) In the “Class” field, enter the name of the class you want to associate with this work. Then press tab to move into the next field.  You can only perform this step if class tracking is turned on.

9. The next seven columns are the columns for each day of the week, Monday through Friday, listed with the dates for the week you are entering.  For each day of the week that work was performed for this customer and item, enter the number of hours worked in the appropriate date column.

10. When you are making entries, QuickBooks automatically assumes you are going to bill the customer for this time.  If you are not going to bill the customer for the work, click on the invoice symbol that appears in the next column when you are making the time entries.  Clicking on the symbol will place a red “X” over it.  If the invoice symbol is clear/white, it means that you want to bill the customer, but have not done the invoice for that time yet.  If a red “X” covers the invoice symbol, it means you are not going to bill the customer for that time.  If the invoice symbol is gray, this indicates that you have already billed the customer for this time.  

11.  Repeat Steps 3 through 10 to add additional lines for time spent on other jobs, doing other services, or associated with other payroll items.

12. Record the timesheet:

♣To record and close the window, click “Save and Close”.
♣To record and display a weekly timesheet for a different person for the same week, enter the new person’s name in the “Name” field.

♣To record and display a new, blank weekly timesheet for the same week, click “Save and New”

♣To record and display a weekly timesheet for this person for next week, click “Next” at the top of the timesheet.  (Click “Prev” if you want to display the person’s timesheet for last week.)

TIME TRACKING

Printing timesheets

1. You can now print the individual timesheets from the entry screen.

2. You can print multiple timesheets at once from the “File” menu, choose print “Forms” and then choose “Timesheets”.

3. (Optional) Change the date range for the timesheets by entering different dates in the “Dated” and “Thru” fields.  

· QuickBooks initially assumes that you want to print timesheets for the current workweek. By changing the dates, you can print timesheets for other weeks.

4. In the list of names, make sure that all the people for whom you want to print timesheets are selected. If you do not want to print a timesheet for someone, click the checkmark next to his/her name to make the checkmark disappear.  If the list is long and you only want to print timesheets for a few people, click “Select None”. In the first column, click next to the name of each person for whom you want to print a timesheet to make a checkmark appear.

5. (Optional) To print the full text of your activity notes on each timesheet, select “Print full activity notes.” at the bottom of the window.  If you don’t select this option, QuickBooks prints only the first line of each note.

6. (Optional) Click “Preview” to see on your screen what each timesheet will look like when printed.

7. To print the timesheets:

A. Click “OK” from the “Print Timesheets” window.

TO DO NOTES

About To Do Notes

“To Do Notes” are used to remind yourself of tasks you want to complete by a certain date.  You can look at your notes in the “To Do” list at any time, or you can use the “Reminders” list to see the notes whose dates are due.

Creating To Do Notes

1. From the Company menu, choose To Do List.

2. From the “To Do” menu button at the bottom of the window, choose “New”.

3. Enter the text of the note in the “Note” field as you want it to appear on the “To Do” list.

♣Tip:  If you have a lot of detail to put into the note but you want the entry in the “To Do” list to be short, enter a short title, press the Enter key, and then enter the rest of the note.  Only the title will appear on the “To Do” list.

4. In the “Remind me on” field, enter the date you want the note to appear on your “Reminders” list. For example, if you enter May 15, the note will not appear on the list until May 15.

5. Click “OK” when you are done entering the note.

♣Be aware that if you create a “To Do” note in multi-user mode while in QuickBooks Pro, everyone using the company file can see the note.

Marking To Do notes as “done”

When you finish the task for which you created a “To Do Note”, you can mark the note as “done.”  Notes marked as done move to the bottom of your “To Do” list.

1. From the Company menu, choose To Do List.

2. From the “To Do” list, double-click the task you want to mark as “Done”.

3. Check the “Done” checkbox in the bottom of the window, and click “OK”.  This moves the note to the bottom of the “To Do” list and removes the note from the “Reminders” list.

If you no longer need the note . . .

You can delete it by selecting the note in the “To Do” list and choosing “Delete Note” from the main “Edit” menu at the top of your QuickBooks screen.

TO DO NOTES

Editing To Do Notes

You can edit your “To Do” notes at any time.  If you use the note on a recurring basis, you can change the note’s reminder date.  You can also revise the note’s original text, add new text, or mark the note as done.

1. From the Company menu, choose To Do List.

2. When the “To Do” list appears, double-click the note you would like to edit.  You can also choose to edit the note from the “To Do” list by double-clicking the note.

3. Enter the changes you would like to make to the text of the note.

4. If you want the note to appear again on your “Reminders” list, change the reminder date in the “Remind Me On” field.

♣You can reuse your notes to remind yourself about recurring tasks, such as paying monthly bills or preparing quarterly tax forms

5. (Optional) If the note was for a one-time task that you have completed, select the “Done” checkbox.  This moves the note to the bottom of the “To Do” list and removes the note from the “Reminders” list.

6. Click “OK” when you are done entering the note.

Printing To Do notes

1. From the Company menu, choose To Do List.

2. From the “To Do” menu button at the bottom of the window, choose “Print List”.

♣You might get a message suggesting you create a report instead.  For now, click OK”.  If you later decide you want greater control over the appearance of the printed “To Do list, create a report.

3. Select a Printer to print to, or one of three file formats to save the list in.

4. Click “Print” to start printing the list (or to specify a filename for the disk file).

Marking the Note Inactive

You can mark a note “Inactive” instead of done, this will make the note disappear from your “To Do List” but will not delete it from QuickBooks.  This way you can keep track of your past “To Do Lists” but you do not have to have them cluttered by “Done” notes.

1. Display the “To Do” list by choosing “Company” and selecting “To Do List”.

2. Highlight the “To Do Note” you want to mark “Inactive”.  

3. From the “To Do” menu button and the bottom of the window, choose “Make Inactive”.

4. You will see the note is removed from your “To Do” list.  You can make the note reappear by selecting “Show All To Do Notes” from the “To Do” menu button.  

5. Your inactive notes will appear with an X icon to the left of them.  Highlight the note you wish to make active again.

6. Click “Make Active” from the “To Do” menu button and your note will now be placed among the rest of your active notes OR simply click on the X icon to make the note active again. 

VENDORS

Setting up a Vendor 

You can add new vendors to your vendor list at any time. The Vendor list holds information about the people and companies you do business with.

1. From the Lists menu, choose Vendor List.  

2. From the Vendor menu button, choose New.

3. In the “Vendor” field, enter the name of the vendor, as you’d like it to appear on your vendor list.   (If the vendor is an individual and you list individuals last name first, you should enter the name with the last name first.)

4. You will see two tabs in the “New Vendor” window: “Address Info” and “Additional Info”.  “Address Info”, by default, is the tab that appears on top for you to begin entering in the information.

5. The “Address Info” tab holds contact information about the vendor.  You should enter the appropriate information in the following fields: “Company name”, “Mr./Ms.”, “First name, M.I., Last name”, “Address”, “Phone”, “FAX”, “Alt. Ph.”, “Alt. Contact”, “E-Mail”,  “Print on check as”.  As you enter information in the beginning fields, QuickBooks automatically begins to fill in the rest of the fields.  You should fill in as much information as you have available.  “Print on check as” field will be filled in with the information you entered in the vendor’s “Company Name” field, but you can edit it to read exactly as you would like it entered on the check.  If there are any other fields that you need to have listed for each vendor, there is an option to set those up on the “Additional Info” tab.

♣“Company name” - Fill in the vendor’s company name. (If you send a 1099-MISC form to this vendor, enter the company’s legal name.)

♣“Mr./Ms.” - Enter the vendor’s salutation or title (Mr., Ms., Dr., etc.) here. For a married couple, you can enter “Mr. and Mrs.”

♣“First name”, “M.I.”, “Last name” - Enter the first name, middle initial (M.I.), and last name of the person who is your main contact when you do business with this vendor. If the vendor is a large corporation (for example, your utility company), you can leave these fields blank.  (If you send a 1099-MISC form to this vendor, you must enter the vendor’s legal name in these fields.)

♣“Address” - Complete the vendor’s address (QuickBooks has partially filled in the “Address” field based on what you’ve entered so far). Enter the address as you want it to appear on printed checks to the vendor.  (If you send a 1099-MISC form to this vendor, you must include the city, the two-letter state abbreviation, and the zip code. Do not change the part of the address that QuickBooks filled in.)

♣“Phone”, “FAX”, “Alt. PH.”, ”Alt. Contact” and “E-Mail” - Enter, as needed, the vendor’s phone number, fax number, and alternate phone number; and the name of an alternate contact person and the company main e-mail address.

♣“Print on check as” - This is the vendor’s name as it will appear on printed checks you send to the vendor. QuickBooks pre-fills this field with the vendor’s company name, but you can edit the name if you want it to print differently on your checks.

6. Click on the “Additional Info” tab.  The “Additional Info” contains credit, tax-related, and other pertinent information about the vendor.  You should enter the appropriate information in the following fields: “Account”, “Type”, “Terms”, “Credit Limit”, “Tax ID”, “Vendor is eligible for 1099”, “Opening balance… as of”, “Custom fields”.

7. In the “Account” field, enter any information that you want QuickBooks to print in the “Memo” field of checks when you create them.  For example, if you enter your company’s account number with the vendor, QuickBooks automatically adds the account number to the “Memo” field on each bill payment check that goes to that vendor. (You can also enter a short note or message instead of an account number.)  An account number is required if you want to set up this vendor as an online payee. The payee uses this number to identify you.

8. In the “Type” field, enter the type of vendor this is.  This is a word or phrase that categorizes this vendor for your reports. From this drop-down list, you can choose a vendor type you have already set up, or you can enter a new vendor type and have QuickBooks add it to the list.  (A building contractor might use vendor types to categorize subcontractors by location, for example, by county.)  Once you have assigned a vendor type to each vendor, you can create reports that provide useful information about your vendors. For example, if you have categorized your vendors by location, you can create reports that show your expenses for each geographic area.

♣Note: To add a new type, click “Add New” from the drop down list in the “Type” field.  You will get a “New Type” window that will allow you to type in a new category.  Click “Ok” when you have written the new category.

9. Enter a specific set of terms in the “Terms” field.  “Terms” lets you associate a specific set of payment terms with the vendor. When you enter a bill from the vendor, QuickBooks uses the terms to calculate when the bill is due.

10. In the “Credit limit” field, enter the credit limit that your company has with this vendor. QuickBooks warns you when you are about to exceed the limit.

11. The “Tax ID” field can be left blank if you do not send 1099-MISC forms to the vendor.  If you do send 1099-MISC forms to the vendor, then in the “Tax ID” field enter the vendor’s social security number, if the vendor is a sole proprietor; or if the vendor is not a sole proprietor, enter the vendor’s nine-digit tax identification number.

12. In the “Vendor is eligible for 1099” field you should click in the box to make a checkmark appear if you send 1099-MISC forms to this vendor.  If you do not send 1099-MISC forms and have not entered a Tax ID as instructed in number 11 above, then you should unclick the box, so a checkmark does NOT appear in the checkbox.  You can’t select 1099 eligible if you don’t have a tax ID number.

13. The “Opening balance…as of” field has already been established for you so you need to enter no further information here.  This field is only used when you are setting up the company.

14. The final field is “Custom Fields”.  These are used to setup additional information fields that you may want for your vendors.  If custom fields have been set up for vendors then you will see the fields for each vendor.  These additional fields can be used to print or filter on reports.  An example of a custom field might be birthdays or information that you might want to keep track of and there isn’t a field for. 

Keyboard Shortcuts

Keyboard Strokes
(i) Effect

Ctrl + 1
Displays important information about QuickBooks

Ctrl + F1
Turn on/off Q Cards

Ctrl + D
Delete transactions

Ctrl + F
Find transaction

Ctrl + H
History of A/R or A/P transaction

Ctrl + L
Display list

Ctrl + M 
Memorize transaction

Ctrl + O 
Copy transaction in a register

Ctrl + Q
Quick report of list item

Ctrl + R
Use register

Ctrl + U
Use item on a list

Ctrl + V
Paste transaction in register

Ctrl + Y
Display transaction journal

Ctrl + (
Next word in field

Ctrl + (
Previous word in field

Ctrl + Del
Delete line item

Ctrl + Ins
Insert line item

Ctrl + Page Up
First item in list or previous month in register

Ctrl + Page Down
Last item in list of next month in register

Type first few letters
QuickFill name on a list

Shift
Window is centered on screen

Enter
Record (when border is around OK, Next, or Prev button)

Ctrl + Enter 
Record (always)

Tab
Moves to the next field

Shift + Tab
Moves to the prior field

Escape
Cancels transaction or closes window

Ctrl + Z
Undoes changes made to field

Up Arrow
Moves to line above in detail area

Down Arrow
Moves to line below in detail area

+
Increase form number or increase date

-
Decrease form number or decrease date

R
Changes date to end of year

Y
Changes date to beginning of year

M
Changes date to beginning of month

H
Changes date to end of month

T
Changes date to today’s date

Space Bar
Use to mark or unmark boxes with check marks

Ctrl + Up Arrow
Scrolls through individual entries on a list while in a form

Alt + Down Arrow
Displays the list on a form

Diamond
Use the diamond on lists to move the item to another position or to make subaccounts, sub-items, or jobs.
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